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This Computer program (including software design, programming structure, graphics, manual, and on-line 
help) was created and published by STRUCTUREPOINT, formerly the Engineering Software Group of the 
Portland Cement Association (PCA), for engineering design and investigation of reinforced concrete sections 
subject to axial and flexural loads.  
 
 
 
 
 
 
While STRUCTUREPOINT has taken every precaution to utilize the existing state-of-the-art and to assure the correctness of the 
analytical solution techniques used in this program, the responsibilities for modeling the structure, inputting data, applying engineering 
judgment to evaluate the output, and implementing engineering drawings remain with the structural engineer of record. Accordingly, 
STRUCTUREPOINT does and must disclaim any and all responsibility for defects or failures of structures in connection with which this 
program is used. 
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License Agreements 
STRUCTUREPOINT EVALUATION SOFTWARE LICENSE AGREEMENT 

BY CLICKING THE “I AGREE” ICON BELOW, OR BY INSTALLING, COPYING, OR OTHERWISE USING THE SOFTWARE 
OR USER DOCUMENTATION, YOU AGREE TO BE BOUND BY THE TERMS OF THIS AGREEMENT, INCLUDING, BUT NOT 
LIMITED TO, THE WARRANTY DISCLAIMERS, LIMITATIONS OF LIABILITY AND TERMINATION PROVISIONS BELOW. 
IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, DO NOT INSTALL OR USE THE SOFTWARE OR USER 
DOCUMENTATION, EXIT THIS APPLICATION NOW AND RETURN THE SOFTWARE AND USER DOCUMENTATION TO 
STRUCTUREPOINT.  

STRUCTUREPOINT, 5420 OLD ORCHARD ROAD, SKOKIE, ILLINOIS 60077, GRANTS THE CUSTOMER A PERSONAL, 
NONEXCLUSIVE, LIMITED, NONTRANSFERABLE LICENSE TO USE THIS SOFTWARE AND USER DOCUMENTATION 
SOLELY FOR TRIAL AND EVALUATION PURPOSES ONLY IN ACCORDANCE WITH THE TERMS AND CONDITIONS OF 
THIS AGREEMENT. SOFTWARE AND USER DOCUMENTATION IS SUPPLIED TO CUSTOMER EITHER BY 
STRUCTUREPOINT DIRECTLY OR THROUGH AN AUTHORIZED DEALER OF STRUCTUREPOINT (HEREAFTER DEALER). 

WHILE STRUCTUREPOINT HAS TAKEN PRECAUTIONS TO ASSURE THE CORRECTNESS OF THE ANALYTICAL 
SOLUTION AND DESIGN TECHNIQUES USED IN THIS SOFTWARE, IT CANNOT AND DOES NOT GUARANTEE ITS 
PERFORMANCE, NOR CAN IT OR DOES IT BEAR ANY RESPONSIBILITY FOR DEFECTS OR FAILURES IN STRUCTURES 
IN CONNECTION WITH WHICH THIS SOFTWARE MAY BE USED. DEALER (IF ANY) HAS NOT PARTICIPATED IN THE 
DESIGN OR DEVELOPMENT OF THIS SOFTWARE AND NEITHER GUARANTEES THE PERFORMANCE OF THE 
SOFTWARE NOR BEARS ANY RESPONSIBILITY FOR DEFECTS OR FAILURES IN STRUCTURES IN CONNECTION WITH 
WHICH THIS SOFTWARE IS USED. 

STRUCTUREPOINT AND DEALER (IF ANY) EXPRESSLY DISCLAIM ANY WARRANTY THAT: (A) THE FUNCTIONS 
CONTAINED IN THE SOFTWARE WILL MEET THE REQUIREMENTS OF CUSTOMER OR OPERATE IN COMBINATIONS 
THAT MAY BE SELECTED FOR USE BY CUSTOMER; (B) THE OPERATION OF THE SOFTWARE WILL BE FREE OF ALL 
"BUGS" OR PROGRAM ERRORS; OR (C) THE SOFTWARE CONFORMS TO ANY PERFORMANCE SPECIFICATIONS. 
CUSTOMER ACKNOWLEDGES THAT STRUCTUREPOINT IS UNDER NO OBLIGATION TO PROVIDE ANY SUPPORT, 
UPDATES, BUG FIXES OR ERROR CORRECTIONS TO OR FOR THE SOFTWARE OR USER DOCUMENTATION.  

THE LIMITED WARRANTIES IN SECTION 6 HEREOF ARE IN LIEU OF ALL OTHER WARRANTIES, EXPRESS OR 
IMPLIED, INCLUDING, BUT NOT LIMITED TO, ANY IMPLIED WARRANTIES OF NON-INFRINGEMENT, 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, EACH OF WHICH IS HEREBY DISCLAIMED. 
EXCEPT AS SET FORTH IN SECTION 6, THE SOFTWARE AND USER DOCUMENTATION ARE PROVIDED ON AN 
"AS-IS" BASIS.  

IN NO EVENT SHALL STRUCTUREPOINT OR DEALER (IF ANY) BE LIABLE FOR: (A) LOSS OF PROFITS, DIRECT, 
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, PUNITIVE, CONSEQUENTIAL OR OTHER DAMAGES, EVEN IF 
STRUCTUREPOINT OR DEALER (IF ANY) HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES; (B) ANY 
CLAIM AGAINST CUSTOMER BY ANY THIRD PARTY; OR (C) ANY DAMAGES CAUSED BY (1) DELAY IN DELIVERY OF 
THE SOFTWARE OR USER DOCUMENTATION UNDER THIS AGREEMENT; (2) THE PERFORMANCE OR NON 
PERFORMANCE OF THE SOFTWARE; (3) RESULTS FROM USE OF THE SOFTWARE OR USER DOCUMENTATION, 
INCLUDING, WITHOUT LIMITATION, MISTAKES, ERRORS, INACCURACIES, FAILURES OR CUSTOMER'S INABILITY TO 
PROVIDE SERVICES TO THIRD PARTIES THROUGH USE OF THE SOFTWARE OR USER DOCUMENTATION; 
(4) CUSTOMER'S FAILURE TO PERFORM CUSTOMER'S RESPONSIBILITIES; (5) STRUCTUREPOINT NOT PROVIDING 
UPDATES, BUG FIXES OR CORRECTIONS TO OR FOR ANY OF THE SOFTWARE OR USER DOCUMENTATION; (6) 
LABOR, EXPENSE OR MATERIALS NECESSARY TO REPAIR DAMAGE TO THE SOFTWARE OR USER DOCUMENTATION 
CAUSED BY (a) ACCIDENT, (b) NEGLIGENCE OR ABUSE BY CUSTOMER, (c) ACTS OF THIRD PERSONS INCLUDING, 
BUT NOT LIMITED TO, INSTALLATION, REPAIR, MAINTENANCE OR OTHER CORRECTIVE WORK RELATED TO ANY 
EQUIPMENT BEING USED, (d) CAUSES EXTERNAL TO THE SOFTWARE SUCH AS POWER FLUCTUATION AND 
FAILURES, OR (e) FLOODS, WINDSTORMS OR OTHER ACTS OF GOD. MOREOVER, IN NO EVENT SHALL 
STRUCTUREPOINT BE LIABLE FOR WARRANTIES, GUARANTEES, REPRESENTATIONS OR ANY OTHER 
UNDERSTANDINGS BETWEEN CUSTOMER AND DEALER (IF ANY) RELATING TO THE SOFTWARE OR USER 
DOCUMENTATION. 

THIS AGREEMENT CONSTITUTES THE ENTIRE AND EXCLUSIVE AGREEMENT BETWEEN CUSTOMER AND 
STRUCTUREPOINT AND DEALER (IF ANY) WITH RESPECT TO THE SOFTWARE AND USER DOCUMENTATION TO BE 
FURNISHED HEREUNDER. IT IS A FINAL EXPRESSION OF THAT AGREEMENT AND UNDERSTANDING. IT SUPERSEDES 
ALL PRIOR COMMUNICATIONS BETWEEN THE PARTIES (INCLUDING ANY EVALUATION LICENSE AND ALL ORAL 
AND WRITTEN PROPOSALS). ORAL STATEMENTS MADE BY STRUCTUREPOINT'S OR DEALER'S (IF ANY) 
REPRESENTATIVES ABOUT THE SOFTWARE OR USER DOCUMENTATION DO NOT CONSTITUTE REPRESENTATIONS 
OR WARRANTIES, SHALL NOT BE RELIED ON BY CUSTOMER, AND ARE NOT PART OF THIS AGREEMENT. 

1. LICENSE RESTRICTIONS  
a. Except as expressly provided in this Agreement or as otherwise authorized in writing by STRUCTUREPOINT, Customer has 

no right to: (1) use, print, copy, display, reverse assemble, reverse engineer, translate or decompile the Software or User 
Documentation in whole or in part; (2) disclose, publish, release, sublicense or transfer to another person any Software or 
User Documentation; (3) reproduce the Software or User Documentation for the use or benefit of anyone other than 
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Customer; or (4) modify any Software or User Documentation. All rights to the Software and User Documentation not 
expressly granted to Customer hereunder are retained by STRUCTUREPOINT. All copyrights and other proprietary rights 
except as expressed elsewhere in the Software or User Documentation and legal title thereto shall remain in 
STRUCTUREPOINT. Customer may use the Software only as licensed by STRUCTUREPOINT on designated workstation 
at Customer's site at any given time. Customer may not transmit the Software licenses electronically to any other workstation, 
computer, node or terminal device whether via a local area network, a wide area network, telecommunications transmission, 
the Internet or other means now known or hereafter created without prior written permission by STRUCTUREPOINT.  

b. Customer acknowledges that this is a limited license for trial and evaluation purposes only. This limited license shall 
automatically terminate upon the earlier of: (1) ten executions of the Software on the computer on which it is installed; or (2) 
fifteen days after the installation of the Software. Thereafter, Customer may only use the Software and Documentation if it 
acquires a production license for the same.  

2. TERM AND TERMINATION  
c. This Agreement shall be in effect from the date Customer clicks the “I AGREE” icon below or installs, copies or otherwise 

uses the Software or User Documentation until: (1) it is terminated by Customer, by Dealer (if any) on behalf of Customer or 
STRUCTUREPOINT or by STRUCTUREPOINT as set forth herein; or (2) the limited trial and evaluation license terminates.  

d. This Agreement may be terminated by STRUCTUREPOINT without cause upon 30 days' written notice or immediately upon 
notice to Customer if Customer breaches this Agreement or fails to comply with any of its terms or conditions. This 
Agreement may be terminated by Customer without cause at any time upon written notice to STRUCTUREPOINT.  

3. BACKUP AND REPLACEMENT COPIES  
Customer may make one copy of the Software for back-up and archival purposes only, provided STRUCTUREPOINT's copyright 
and other proprietary rights notices are included on such copy.  

4. PROTECTION AND SECURITY  
a. Customer shall not provide or otherwise make available any of the Software or User Documentation in any form to any 

person other than employees of Customer with the need to know, without STRUCTUREPOINT's written permission. 

b. All Software and User Documentation in Customer's possession including, without limitation, translations, compilations, 
back-up, and partial copies is the property of STRUCTUREPOINT. Upon termination of this Agreement for any reason, 
Customer shall immediately destroy all Software and User Documentation, including all media, and destroy any Software that 
has been copied onto other magnetic storage devices. Upon STRUCTUREPOINT’s request, Customer shall certify its 
compliance in writing with the foregoing to STRUCTUREPOINT. 

c. Customer shall take appropriate action, by instruction, agreement or otherwise, with any persons permitted access to the 
Software or User Documentation, to enable Customer to satisfy its obligations under this Agreement with respect to use, 
copying, protection, and security of the same. 

d. If STRUCTUREPOINT prevails in an action against Customer for breach of the provisions of this Section 4, Customer shall 
pay the reasonable attorneys' fees, costs, and expenses incurred by STRUCTUREPOINT in connection with such action in 
addition to any award of damages. 

5. CUSTOMER'S RESPONSIBILITIES  
The essential purpose of this Agreement is to provide Customer with limited use rights to the Software and User Documentation. 
Customer accepts full responsibility for: (a) selection of the Software and User Documentation to satisfy Customer's business needs 
and achieve Customer's intended results; (b) the use, set-up and installation of the Software and User Documentation; (c) all results 
obtained from use of the Software and User Documentation; and (d) the selection, use of, and results obtained from any other 
software, programming equipment or services used with the Software or User Documentation. 

6. LIMITED WARRANTIES  
STRUCTUREPOINT and Dealer (if any) warrants to Customer that: (a) STRUCTUREPOINT and Dealer (if any) has title to the 
Software and User Documentation and/or the right to grant Customer the rights granted hereunder; (b) the Software and User 
Documentation provided hereunder is STRUCTUREPOINT's most current production version thereof; and (c) the copy of the 
Software provided hereunder is an accurate reproduction of the original from which it was made.  

7. LIMITATION OF REMEDY  
a. STRUCTUREPOINT AND DEALER (IF ANY) HAS NO LIABILITY UNDER THIS AGREEMENT. CUSTOMER'S 

EXCLUSIVE REMEDY FOR DAMAGES DUE TO PERFORMANCE OR NONPERFORMANCE OF ANY 
SOFTWARE OR USER DOCUMENTATION, STRUCTUREPOINT, DEALER (IF ANY), OR ANY OTHER CAUSE 
WHATSOEVER, AND REGARDLESS OF THE FORM OF ACTION, WHETHER IN CONTRACT OR IN TORT, 
INCLUDING NEGLIGENCE, SHALL BE LIMITED TO CUSTOMER STOPPING ALL USE OF THE SOFTWARE 
AND USER DOCUMENTATION AND RETURNING THE SAME TO STRUCTUREPOINT.  

b. NEITHER STRUCTUREPOINT NOR DEALER (IF ANY) IS AN INSURER WITH REGARD TO THE 
PERFORMANCE OF THE SOFTWARE OR USER DOCUMENTATION. THE TERMS OF THIS AGREEMENT, 
INCLUDING, BUT NOT LIMITED TO, THE LIMITED WARRANTIES, AND THE LIMITATION OF LIABILITY 
AND REMEDY, ARE A REFLECTION OF THE RISKS ASSUMED BY THE PARTIES. IN ORDER TO OBTAIN 
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THE SOFTWARE AND USER DOCUMENTATION FROM STRUCTUREPOINT OR DEALER (IF ANY), 
CUSTOMER HEREBY ASSUMES THE RISKS FOR (1) ALL LIABILITIES DISCLAIMED BY 
STRUCTUREPOINT AND DEALER (IF ANY) ON THE FACE HEREOF; AND (2) ALL ACTUAL OR ALLEGED 
DAMAGES IN CONNECTION WITH THE USE OF THE SOFTWARE AND USER DOCUMENTATION. THE 
ESSENTIAL PURPOSE OF THE LIMITED REMEDY PROVIDED CUSTOMER HEREUNDER IS TO 
ALLOCATE THE RISKS AS PROVIDED ABOVE. 

8. U.S. GOVERNMENT RESTRICTED RIGHTS  
This commercial computer software and commercial computer software documentation were developed exclusively at private 
expense by STRUCTUREPOINT, 5420 Old Orchard Road, Skokie, Illinois, 60077. U.S. Government rights to use, modify, release, 
reproduce, perform, display or disclose this computer software and computer software documentation are subject to the restrictions 
of DFARS 227.7202-1(a) (September 2007) and DFARS 227.7202-3(a) (September 2007), or the Restricted Rights provisions of 
FAR 52.227-14 (December 2007) and FAR 52.227-19 (December 2007), as applicable. 

9. GENERAL  
a. No action arising out of any claimed breach of this Agreement or transactions under this Agreement may be brought by 

Customer more than two years after the cause of such action has arisen. 

b. Customer may not assign, sell, sublicense or otherwise transfer this Agreement, the license granted herein or the Software or 
User Documentation by operation of law or otherwise without the prior written consent of STRUCTUREPOINT. Any attempt 
to do any of the foregoing without STRUCTUREPOINT’s consent is void.  

c. Customer acknowledges that the Software, User Documentation and other proprietary information and materials of 
STRUCTUREPOINT are unique and that, if Customer breaches this Agreement, STRUCTUREPOINT may not have an 
adequate remedy at law and STRUCTUREPOINT may enforce its rights hereunder by an action for damages and/or 
injunctive or other equitable relief without the necessity of proving actual damage or posting a bond therefor. 

d. THE RIGHTS AND OBLIGATIONS UNDER THIS AGREEMENT SHALL NOT BE GOVERNED BY THE UNITED 
NATIONS CONVENTION ON CONTRACTS FOR THE INTERNATIONAL SALE OF GOODS, THE APPLICATION OF 
WHICH IS EXPRESSLY EXCLUDED, BUT SUCH RIGHTS AND OBLIGATIONS SHALL INSTEAD BE GOVERNED 
BY THE LAWS OF THE STATE OF ILLINOIS, APPLICABLE TO CONTRACTS ENTERED INTO AND PERFORMED 
ENTIRELY WITHIN THE STATE OF ILLINOIS AND APPLICABLE FEDERAL (U.S.) LAWS. UCITA SHALL NOT 
APPLY TO THIS AGREEMENT. 

e. THIS AGREEMENT SHALL BE TREATED AS THOUGH IT WERE EXECUTED IN THE COUNTY OF COOK, STATE 
OF ILLINOIS, AND WAS TO HAVE BEEN PERFORMED IN THE COUNTY OF COOK, STATE OF ILLINOIS. ANY 
ACTION RELATING TO THIS AGREEMENT SHALL BE INSTITUTED AND PROSECUTED IN A COURT LOCATED 
IN COOK COUNTY, ILLINOIS. CUSTOMER SPECIFICALLY CONSENTS TO EXTRATERRITORIAL SERVICE OF 
PROCESS. 

f. Except as prohibited elsewhere in this Agreement, this Agreement shall be binding upon and inure to the benefit of the 
personal and legal representatives, permitted successors, and permitted assigns of the parties hereto.  

g. All notices, demands, consents or requests that may be or are required to be given by any party to another party shall be in 
writing. All notices, demands, consents or requests given by the parties hereto shall be sent either by U.S. certified mail, 
postage prepaid or by an overnight international delivery service, addressed to the respective parties. Notices, demands, 
consents or requests served as set forth herein shall be deemed sufficiently served or given at the time of receipt thereof.  

h. The various rights, options, elections, powers, and remedies of a party or parties to this Agreement shall be construed as 
cumulative and no one of them exclusive of any others or of any other legal or equitable remedy that said party or parties 
might otherwise have in the event of breach or default in the terms hereof. The exercise of one right or remedy by a party or 
parties shall not in any way impair its rights to any other right or remedy until all obligations imposed on a party or parties 
have been fully performed. 

i. No waiver by Customer, STRUCTUREPOINT or Dealer (if any) of any breach, provision, or default by the other shall be 
deemed a waiver of any other breach, provision or default.  

j. The parties hereto, and each of them, agree that the terms of this Agreement shall be given a neutral interpretation and any 
ambiguity or uncertainty herein should not be construed against any party hereto. 

k. If any provision of this Agreement or portion thereof is held to be unenforceable or invalid by any court or competent 
jurisdiction, such decision shall not have the effect of invalidating or voiding the remainder of this Agreement, it being the 
intent and agreement of the parties that this Agreement shall be deemed amended by modifying such provision to the extent 
necessary to render it enforceable and valid while preserving its intent or, if such modification is not possible, by substituting 
therefor another provision that is enforceable and valid so as to materially effectuate the parties’ intent.  

Except as set forth herein, this Agreement may be modified or amended only by a written instrument signed by a duly authorized 
representative of STRUCTUREPOINT and Customer. 
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STRUCTUREPOINT SOFTWARE LICENSE AGREEMENT 
BY CLICKING THE “I AGREE” BELOW, OR BY INSTALLING, COPYING, OR OTHERWISE USING THE SOFTWARE OR 
USER DOCUMENTATION, YOU AGREE TO BE BOUND BY THE TERMS OF THIS AGREEMENT, INCLUDING, BUT NOT 
LIMITED TO, THE WARRANTY DISCLAIMERS, LIMITATIONS OF LIABILITY AND TERMINATION PROVISIONS BELOW. 
IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, DO NOT INSTALL OR USE THE SOFTWARE OR USER 
DOCUMENTATION, EXIT THIS APPLICATION NOW AND RETURN THE SOFTWARE AND USER DOCUMENTATION TO 
STRUCTUREPOINT FOR A FULL REFUND WITHIN THIRTY DAYS AFTER YOUR RECEIPT OF THE SOFTWARE AND 
USER DOCUMENTATION. 

STRUCTUREPOINT, 5420 OLD ORCHARD ROAD, SKOKIE, ILLINOIS 60077, GRANTS THE CUSTOMER A PERSONAL, 
NONEXCLUSIVE, LIMITED, NONTRANSFERABLE LICENSE TO USE THIS SOFTWARE AND USER DOCUMENTATION IN 
ACCORDANCE WITH THE TERMS AND CONDITIONS OF THIS AGREEMENT. SOFTWARE AND USER DOCUMENTATION 
IS SUPPLIED TO CUSTOMER EITHER BY STRUCTUREPOINT DIRECTLY OR THROUGH AN AUTHORIZED DEALER OF 
STRUCTUREPOINT (HEREAFTER DEALER). 

WHILE STRUCTUREPOINT HAS TAKEN PRECAUTIONS TO ASSURE THE CORRECTNESS OF THE ANALYTICAL 
SOLUTION AND DESIGN TECHNIQUES USED IN THIS SOFTWARE, IT CANNOT AND DOES NOT GUARANTEE ITS 
PERFORMANCE, NOR CAN IT OR DOES IT BEAR ANY RESPONSIBILITY FOR DEFECTS OR FAILURES IN STRUCTURES 
IN CONNECTION WITH WHICH THIS SOFTWARE IS USED. DEALER (IF ANY) HAS NOT PARTICIPATED IN THE DESIGN 
OR DEVELOPMENT OF THIS SOFTWARE AND NEITHER GUARANTEES THE PERFORMANCE OF THE SOFTWARE NOR 
BEARS ANY RESPONSIBILITY FOR DEFECTS OR FAILURES IN STRUCTURES IN CONNECTION WITH WHICH THIS 
SOFTWARE IS USED. 

STRUCTUREPOINT AND DEALER (IF ANY) EXPRESSLY DISCLAIM ANY WARRANTY THAT: (A) THE FUNCTIONS 
CONTAINED IN THE SOFTWARE WILL MEET THE REQUIREMENTS OF CUSTOMER OR OPERATE IN COMBINATIONS 
THAT MAY BE SELECTED FOR USE BY CUSTOMER; (B) THE OPERATION OF THE SOFTWARE WILL BE FREE OF ALL 
"BUGS" OR PROGRAM ERRORS; OR (C) THE SOFTWARE CONFORMS TO ANY PERFORMANCE SPECIFICATIONS. 
CUSTOMER ACKNOWLEDGES THAT STRUCTUREPOINT IS UNDER NO OBLIGATION TO PROVIDE ANY SUPPORT, 
UPDATES, BUG FIXES OR ERROR CORRECTIONS TO OR FOR THE SOFTWARE OR USER DOCUMENTATION.  

THE LIMITED WARRANTIES IN SECTION 7 HEREOF ARE IN LIEU OF ALL OTHER WARRANTIES, EXPRESS OR 
IMPLIED, INCLUDING, BUT NOT LIMITED TO, ANY IMPLIED WARRANTIES OF NON-INFRINGEMENT, 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, EACH OF WHICH IS HEREBY DISCLAIMED. 
EXCEPT AS SET FORTH IN SECTION 7, THE SOFTWARE AND USER DOCUMENTATION ARE PROVIDED ON AN 
"AS-IS" BASIS.  

IN NO EVENT SHALL STRUCTUREPOINT OR DEALER (IF ANY) BE LIABLE FOR: (A) LOSS OF PROFITS, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, PUNITIVE, CONSEQUENTIAL OR OTHER DAMAGES, EVEN IF STRUCTUREPOINT 
OR DEALER (IF ANY) HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES; (B) ANY CLAIM AGAINST 
CUSTOMER BY ANY THIRD PARTY EXCEPT AS PROVIDED IN SECTION 8 ENTITLED "INFRINGEMENT"; OR (C) ANY 
DAMAGES CAUSED BY (1) DELAY IN DELIVERY OF THE SOFTWARE OR USER DOCUMENTATION UNDER THIS 
AGREEMENT; (2) THE PERFORMANCE OR NONPERFORMANCE OF THE SOFTWARE; (3) RESULTS FROM USE OF THE 
SOFTWARE OR USER DOCUMENTATION, INCLUDING, WITHOUT LIMITATION, MISTAKES, ERRORS, INACCURACIES, 
FAILURES OR CUSTOMER'S INABILITY TO PROVIDE SERVICES TO THIRD PARTIES THROUGH USE OF THE 
SOFTWARE OR USER DOCUMENTATION; (4) CUSTOMER'S FAILURE TO PERFORM CUSTOMER'S RESPONSIBILITIES; (5) 
STRUCTUREPOINT NOT PROVIDING UPDATES, BUG FIXES OR CORRECTIONS TO OR FOR ANY OF THE SOFTWARE OR 
USER DOCUMENTATION; (6) LABOR, EXPENSE OR MATERIALS NECESSARY TO REPAIR DAMAGE TO THE SOFTWARE 
OR USER DOCUMENTATION CAUSED BY (a) ACCIDENT, (b) NEGLIGENCE OR ABUSE BY CUSTOMER, (c) ACTS OF 
THIRD PERSONS INCLUDING, BUT NOT LIMITED TO, INSTALLATION, REPAIR, MAINTENANCE OR OTHER 
CORRECTIVE WORK RELATED TO ANY EQUIPMENT BEING USED, (d) CAUSES EXTERNAL TO THE SOFTWARE SUCH 
AS POWER FLUCTUATION AND FAILURES, OR (e) FLOODS, WINDSTORMS OR OTHER ACTS OF GOD. MOREOVER, IN 
NO EVENT SHALL STRUCTUREPOINT BE LIABLE FOR WARRANTIES, GUARANTEES, REPRESENTATIONS OR ANY 
OTHER UNDERSTANDINGS BETWEEN CUSTOMER AND DEALER (IF ANY) RELATING TO THE SOFTWARE OR USER 
DOCUMENTATION. 

THIS AGREEMENT CONSTITUTES THE ENTIRE AND EXCLUSIVE AGREEMENT BETWEEN CUSTOMER AND 
STRUCTUREPOINT AND DEALER (IF ANY) WITH RESPECT TO THE SOFTWARE AND USER DOCUMENTATION TO BE 
FURNISHED HEREUNDER. IT IS A FINAL EXPRESSION OF THAT AGREEMENT AND UNDERSTANDING. IT SUPERSEDES 
ALL PRIOR COMMUNICATIONS BETWEEN THE PARTIES (INCLUDING ANY EVALUATION LICENSE AND ALL ORAL 
AND WRITTEN PROPOSALS). ORAL STATEMENTS MADE BY STRUCTUREPOINT 'S OR DEALER'S (IF ANY) 
REPRESENTATIVES ABOUT THE SOFTWARE OR USER DOCUMENTATION DO NOT CONSTITUTE REPRESENTATIONS 
OR WARRANTIES, SHALL NOT BE RELIED ON BY CUSTOMER, AND ARE NOT PART OF THIS AGREEMENT. 

1. LICENSE RESTRICTIONS  
a. Except as expressly provided in this Agreement or as otherwise authorized in writing by STRUCTUREPOINT, Customer has 

no right to: (1) use, print, copy, display, reverse assemble, reverse engineer, translate or decompile the Software or User 
Documentation in whole or in part; (2) disclose, publish, release, sublicense or transfer to another person any Software or 
User Documentation; (3) reproduce the Software or User Documentation for the use or benefit of anyone other than 
Customer; or (4) modify any Software or User Documentation. All rights to the Software and User Documentation not 
expressly granted to Customer hereunder are retained by STRUCTUREPOINT. All copyrights and other proprietary rights 
except as expressed elsewhere in the Software or User Documentation and legal title thereto shall remain in 
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STRUCTUREPOINT. Customer may use the Software only as licensed by STRUCTUREPOINT on designated workstation 
at Customer's site at any given time. Customer may not transmit the Software licenses electronically to any other workstation, 
computer, node or terminal device whether via a local area network, a wide area network, telecommunications transmission, 
the Internet or other means now known or hereafter created without prior written permission by STRUCTUREPOINT. 

b. Customer acknowledges that the registration process for the Software results in the generation of a unique license code. Once 
the license code is entered DURING THE INSTALLATION PROCESS, the Software will only work on the computer on 
which the Software LICENSE is INITIALLY installed. If you need to deinstall the Software license and reinstall the Software 
license on a different computer, you must contact STRUCTUREPOINT to obtain the necessary reinstallation procedures. 

2. CHARGES AND PAYMENTS  
All payments for the Software and User Documentation shall be made to either STRUCTUREPOINT or Dealer (if any), as 
appropriate. 

3. TERM AND TERMINATION  
a. This Agreement shall be in effect from the date Customer clicks the “I AGREE” below or installs, copies or otherwise uses 

the Software or User Documentation until it is terminated by Customer, by Dealer (if any) on behalf of Customer or 
STRUCTUREPOINT or by STRUCTUREPOINT as set forth herein. 

b. This Agreement may be terminated by STRUCTUREPOINT without cause upon 30 days' written notice or immediately upon 
notice to Customer if Customer breaches this Agreement or fails to comply with any of its terms or conditions. This 
Agreement may be terminated by Customer without cause at any time upon written notice to STRUCTUREPOINT.  

4. BACKUP AND REPLACEMENT COPIES  
Customer may make one copy of the Software for back-up and archival purposes only, provided STRUCTUREPOINT's copyright 
and other proprietary rights notices are included on such copy.  

5. PROTECTION AND SECURITY  
a. Customer shall not provide or otherwise make available any of the Software or User Documentation in any form to any 

person other than employees of Customer with the need to know, without STRUCTUREPOINT's written permission. 

b. All Software and User Documentation in Customer's possession including, without limitation, translations, compilations, 
back-up, and partial copies is the property of STRUCTUREPOINT. Upon termination of this Agreement for any reason, 
Customer shall immediately destroy all Software and User Documentation, including all media, and destroy any Software that 
has been copied onto other magnetic storage devices. Upon STRUCTUREPOINT’s request, Customer shall certify its 
compliance in writing with the foregoing to STRUCTUREPOINT. 

c. Customer shall take appropriate action, by instruction, agreement or otherwise, with any persons permitted access to the 
Software or User Documentation, to enable Customer to satisfy its obligations under this Agreement with respect to use, 
copying, protection, and security of the same. 

d. If STRUCTUREPOINT prevails in an action against Customer for breach of the provisions of this Section 5, Customer shall 
pay the reasonable attorneys' fees, costs, and expenses incurred by STRUCTUREPOINT in connection with such action in 
addition to any award of damages. 

6. CUSTOMER'S RESPONSIBILITIES  
The essential purpose of this Agreement is to provide Customer with limited use rights to the Software and User Documentation. 
Customer accepts full responsibility for: (a) selection of the Software and User Documentation to satisfy Customer's business needs 
and achieve Customer's intended results; (b) the use, set-up and installation of the Software and User Documentation; (c) all results 
obtained from use of the Software and User Documentation; and (d) the selection, use of, and results obtained from any other 
software, programming equipment or services used with the Software or User Documentation. 

7. LIMITED WARRANTIES  
STRUCTUREPOINT and Dealer (if any) warrants to Customer that: (a) STRUCTUREPOINT and Dealer (if any) has title to the 
Software and User Documentation and/or the right to grant Customer the rights granted hereunder; (b) the Software and User 
Documentation provided hereunder is STRUCTUREPOINT's most current production version thereof; and (c) the copy of the 
Software provided hereunder is an accurate reproduction of the original from which it was made. 

8. INFRINGEMENT  
a. STRUCTUREPOINT shall defend Customer against a claim that the Software or User Documentation furnished and used 

within the scope of the license granted hereunder infringes a U.S. patent or U.S. registered copyright of any third party that 
was issued or registered, as applicable, as of the date Customer clicked the “I AGREE” below or installed, copied or 
otherwise began using the Software or User Documentation, and STRUCTUREPOINT shall pay resulting costs, damages, 
and attorneys' fees finally awarded, subject to the limitation of liability set forth in Section 9 entitled "Limitation of Remedy," 
provided that: 
1. Customer promptly notifies STRUCTUREPOINT in writing of the claim. 
2. STRUCTUREPOINT has sole control of the defense and all related settlement negotiations.  
3. If such claim has occurred or in STRUCTUREPOINT's opinion is likely to occur, Customer shall permit 
STRUCTUREPOINT at its sole option and expense either to procure for Customer the right to continue using the Software or 
User Documentation or to replace or modify the same so that it becomes noninfringing. If neither of the foregoing alternatives 
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is reasonably available in STRUCTUREPOINT's sole judgment, Customer shall, on one month's written notice from 
STRUCTUREPOINT, return to STRUCTUREPOINT the Software and User Documentation and all copies thereof. 

b. STRUCTUREPOINT shall have no obligation to defend Customer or to pay costs, damages or attorneys' fees for any claim 
based upon (1) use of other than a current unaltered release of the Software or User Documentation, or (2) the combination, 
operation or use of any Software or User Documentation furnished hereunder with any other software, documentation or data 
if such infringement would have been avoided but for the combination, operation or use of the Software or User 
Documentation with other software, documentation or data. 

c. The foregoing states the entire obligation of STRUCTUREPOINT and Customer’s sole remedy with respect to infringement 
matters relating to the Software and User Documentation. 

9. LIMITATION OF REMEDY  
a. STRUCTUREPOINT'S AND DEALER'S (IF ANY) ENTIRE LIABILITY AND CUSTOMER'S EXCLUSIVE REMEDY 

FOR DAMAGES DUE TO PERFORMANCE OR NONPERFORMANCE OF ANY SOFTWARE OR USER 
DOCUMENTATION, STRUCTUREPOINT, DEALER (IF ANY), OR ANY OTHER CAUSE WHATSOEVER, AND 
REGARDLESS OF THE FORM OF ACTION, WHETHER IN CONTRACT OR IN TORT, INCLUDING NEGLIGENCE, 
SHALL BE LIMITED TO THE AMOUNT PAID TO STRUCTUREPOINT OR DEALER (IF ANY) FOR THE 
SOFTWARE AND USER DOCUMENTATION. 

b. NEITHER STRUCTUREPOINT NOR DEALER (IF ANY) IS AN INSURER WITH REGARD TO THE 
PERFORMANCE OF THE SOFTWARE OR USER DOCUMENTATION. THE TERMS OF THIS AGREEMENT, 
INCLUDING, BUT NOT LIMITED TO, THE LIMITED WARRANTIES, AND THE LIMITATION OF LIABILITY 
AND REMEDY, ARE A REFLECTION OF THE RISKS ASSUMED BY THE PARTIES. IN ORDER TO OBTAIN 
THE SOFTWARE AND USER DOCUMENTATION FROM STRUCTUREPOINT OR DEALER (IF ANY), 
CUSTOMER HEREBY ASSUMES THE RISKS FOR (1) ALL LIABILITIES DISCLAIMED BY 
STRUCTUREPOINT AND DEALER (IF ANY) ON THE FACE HEREOF; AND (2) ALL ACTUAL OR ALLEGED 
DAMAGES IN EXCESS OF THE AMOUNT OF THE LIMITED REMEDY PROVIDED HEREUNDER. THE 
ESSENTIAL PURPOSE OF THE LIMITED REMEDY PROVIDED CUSTOMER HEREUNDER IS TO 
ALLOCATE THE RISKS AS PROVIDED ABOVE.  

10. U.S. GOVERNMENT RESTRICTED RIGHTS  
This commercial computer software and commercial computer software documentation were developed exclusively at private 
expense by STRUCTUREPOINT, 5420 Old Orchard Road, Skokie, Illinois 60077. U.S. Government rights to use, modify, release, 
reproduce, perform, display or disclose this computer software and computer software documentation are subject to the restrictions 
of DFARS 227.7202-1(a) (September 2007) and DFARS 227.7202-3(a) (September 2007), or the Restricted Rights provisions of 
FAR 52.227-14 (December 2007) and FAR 52.227-19 (December 2007), as applicable. 

11. GENERAL  
a. No action arising out of any claimed breach of this Agreement or transactions under this Agreement may be brought by 

Customer more than two years after the cause of such action has arisen. 

b. Customer may not assign, sell, sublicense or otherwise transfer this Agreement, the license granted herein or the Software or 
User Documentation by operation of law or otherwise without the prior written consent of STRUCTUREPOINT. Any attempt 
to do any of the foregoing without STRUCTUREPOINT’s consent is void.  

c. Customer acknowledges that the Software, User Documentation and other proprietary information and materials of 
STRUCTUREPOINT are unique and that, if Customer breaches this Agreement, STRUCTUREPOINT may not have an 
adequate remedy at law and STRUCTUREPOINT may enforce its rights hereunder by an action for damages and/or 
injunctive or other equitable relief without the necessity of proving actual damage or posting a bond therefor. 

d. THE RIGHTS AND OBLIGATIONS UNDER THIS AGREEMENT SHALL NOT BE GOVERNED BY THE UNITED 
NATIONS CONVENTION ON CONTRACTS FOR THE INTERNATIONAL SALE OF GOODS, THE APPLICATION OF 
WHICH IS EXPRESSLY EXCLUDED, BUT SUCH RIGHTS AND OBLIGATIONS SHALL INSTEAD BE GOVERNED 
BY THE LAWS OF THE STATE OF ILLINOIS, APPLICABLE TO CONTRACTS ENTERED INTO AND PERFORMED 
ENTIRELY WITHIN THE STATE OF ILLINOIS AND APPLICABLE FEDERAL (U.S.) LAWS. UCITA SHALL NOT 
APPLY TO THIS AGREEMENT.  

e. THIS AGREEMENT SHALL BE TREATED AS THOUGH IT WERE EXECUTED IN THE COUNTY OF COOK, STATE 
OF ILLINOIS, AND WAS TO HAVE BEEN PERFORMED IN THE COUNTY OF COOK, STATE OF ILLINOIS. ANY 
ACTION RELATING TO THIS AGREEMENT SHALL BE INSTITUTED AND PROSECUTED IN A COURT LOCATED 
IN COOK COUNTY, ILLINOIS. CUSTOMER SPECIFICALLY CONSENTS TO EXTRATERRITORIAL SERVICE OF 
PROCESS.  

f. Except as prohibited elsewhere in this Agreement, this Agreement shall be binding upon and inure to the benefit of the 
personal and legal representatives, permitted successors, and permitted assigns of the parties hereto.  

g. All notices, demands, consents or requests that may be or are required to be given by any party to another party shall be in 
writing. All notices, demands, consents or requests given by the parties hereto shall be sent either by U.S. certified mail, 
postage prepaid or by an overnight international delivery service, addressed to the respective parties. Notices, demands, 
consents or requests served as set forth herein shall be deemed sufficiently served or given at the time of receipt thereof.  
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h. The various rights, options, elections, powers, and remedies of a party or parties to this Agreement shall be construed as 
cumulative and no one of them exclusive of any others or of any other legal or equitable remedy that said party or parties 
might otherwise have in the event of breach or default in the terms hereof. The exercise of one right or remedy by a party or 
parties shall not in any way impair its rights to any other right or remedy until all obligations imposed on a party or parties 
have been fully performed. 

i. No waiver by Customer, STRUCTUREPOINT or Dealer (if any) of any breach, provision, or default by the other shall be 
deemed a waiver of any other breach, provision or default.  

j. The parties hereto, and each of them, agree that the terms of this Agreement shall be given a neutral interpretation and any 
ambiguity or uncertainty herein should not be construed against any party hereto. 

k. If any provision of this Agreement or portion thereof is held to be unenforceable or invalid by any court or competent 
jurisdiction, such decision shall not have the effect of invalidating or voiding the remainder of this Agreement, it being the 
intent and agreement of the parties that this Agreement shall be deemed amended by modifying such provision to the extent 
necessary to render it enforceable and valid while preserving its intent or, if such modification is not possible, by substituting 
therefor another provision that is enforceable and valid so as to materially effectuate the parties’ intent.  

Except as set forth herein, this Agreement may be modified or amended only by a written instrument signed by a duly authorized 
representative of STRUCTUREPOINT and Customer. 

 

April 2009 

 

 





 

 

Chapter 1  – Introduction 
Introduction 

spColumn is a software program for the design and investigation of reinforced concrete sections subject to 
axial and flexural loads. The section can be rectangular, round or irregular, with any reinforcement layout or 
pattern. Slenderness effects can be considered. 

The program offers investigation of irregularly shaped, reinforced concrete column sections that may contain 
openings or boundary elements. Widely used for design of shear walls, bridge piers as well as typical framing 
elements in buildings, spColumn can investigate sections that are impossible to find on design charts or do by 
hand calculations. You can obtain the P-M interaction diagrams from both uniaxial and biaxial runs, as well 
as the Mx-My moment contour plots from biaxial runs for even the most irregular column and shear wall 
sections. Slenderness effects producing magnified moments may be included in the investigation. 

Program Features 
• ACI 318-08, ACI 318-05, ACI 318-02, CSA A23.3-04, and CSA A23.3-94 

• English and SI units 

• Design and investigation run options 

• Uniaxial or biaxial flexure combined with axial load 

• Rectangular, circular, and irregular section geometry 

• Non-slender and sway or nonsway slender columns 

• Complete P-M and Mx-My interaction diagrams 

• Customizable view of interaction diagrams 

• Superposition of interaction diagram from a different run 

• Factored, unfactored, axial, and control points loading 

• Binary (COL) and text (CTI) input file formats 

• Graphical input for irregular sections 

• Imports geometry, reinforcement, and loads from text files 

• Imports section shape and reinforcement from DXF files 

• Exports section shape and reinforcement to DXF files 

• Exports graphical reports (screen printouts) to EMF files 

• Exports P-M diagrams, Mx-My diagrams, and 3D failure surface to TXT and CSV files 

• GUI (Graphical User Interface) and batch (command prompt) mode runs 

• Reports neutral axis location and maximum steel strain corresponding to section capacity 

• Reports strength reduction factors in text output 

Program Capacity 
• 10,000 reinforcing bars within a section.  
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• 10,000 exterior points that define the geometric outline of the cross section (spSection module).  

• 10,000 interior points that define an opening in the cross section (spSection module).  

• 5,000 factored load entries, each consisting of an axial load, a moment about the x-axis, and a moment 
about the y-axis.  

• 50 service load entries, each consisting of dead, live, wind, earthquake, and snow axial loads, moments at 
column top about the x and y axes, and moments at column bottom about the x and y axes. 

• 50 load combinations. 

System Requirements 
Any computer running Microsoft Windows XP, Windows Vista, or Windows 7 operating system is sufficient 
to run the spColumn program. For instructions on how to troubleshoot system specific installation and 
licensing issues, please refer to support pages on StructurePoint website at www.StructurePoint.org. 

Terms 
The following terms are used throughout this manual. A brief explanation is given to help familiarize you 
with them. 

Windows refers to the Microsoft Windows environment version 3.1 or higher. 
 

[ ] indicates metric equivalent 
 

Click on means to position the cursor on top of a designated item or location and press and 
release the left-mouse button (unless instructed to use the right-mouse button). 
 

Double-click on means to position the cursor on top of a designated item or location and press and 
release the left-mouse button twice in quick succession. 
 

Conventions 
To help you locate and interpret information easily, the spColumn manual adheres to the following text 
format. 

Italic indicates a glossary item, or emphasizes a given word or phrase. 
 

Bold indicates the name of a menu or a menu item command such as File or Save. 
 

Mono-space indicates something you should enter with the keyboard. For example “c:\*.txt”. 
 

KEY + KEY indicates a key combination. The plus sign indicates that you should press and hold the 
first key while pressing the second key, then release both keys. For example, “ALT + 
F” indicates that you should press the “ALT” key and hold it while you press the “F” 
key. then release both keys. 
 

SMALL CAPS Indicates the name of an object such as a dialog box or a dialog box component. For 
example, the OPEN dialog box or the CANCEL or MODIFY buttons. 
 

Installing, Purchasing and Licensing spColumn 
For instructions on how to install, purchase, and license StructurePoint software please refer to support pages 
on StructurePoint website at www.StructurePoint.org. 

http://www.structurepoint.org/�
http://www.structurepoint.org/�


 

 

Chapter 2  – Method of Solution 
Method of Solution 

A – Definitions and Assumptions 
1. The analysis of the reinforced concrete section performed by spColumn conforms to the provisions of the 

Strength Design Method1 and Unified Design Provisions2 and is based on the following assumptions.  

a) All conditions of strength satisfy the applicable conditions of equilibrium and strain compatibility3 
b) Strain in the concrete and in the reinforcement is directly proportional to the distance from the 

neutral axis4  
c) The maximum usable (ultimate) strain at the extreme concrete compression fiber is assumed equal to 

0.003 for ACI codes5 and 0.0035 for CSA codes6 unless otherwise specified by the user 
d) A uniform rectangular concrete stress block is used. For ACI code7, the maximum uniform concrete 

compressive stress, cf , is c0.85f ′  and the block depth is 1cβ , where c  is the distance from the 
extreme compression fiber to the neutral axis and 1β  is described in item 4 below. For CSA8, cf is 
taken as: 

( )c c c cf 0.85 0.0015f f 0.67f′ ′ ′= − ≥ , where cf ′  is in MPa 

Both cf  and 1β  can be modified by the user. 

e) Concrete displaced by the reinforcement in compression is deducted from the compression block9  
f) For the reinforcing steel, the elastic-plastic stress-strain distribution is used10. Stress in the 

reinforcing steel below the yield strength, yf , is directly proportional to the strain. For strains greater 
than that corresponding to the yield strength, the reinforcement stress remains constant and equal to 

yf . 

g) Tensile strength of concrete is neglected11. 
h) Reinforcement bars are located within section outline. 

2. The modulus of elasticity of concrete, cE , is computed as follows (unless otherwise specified by the 
user): 

c cE 57,000 f ′= , for the ACI code12 where cf ′  and cE  are in psi, 

c cE 4,700 f ′= , for the ACI code13 where cf ′  and cE  are in MPa. 

For the CSA standard14, c cE 3,518 f 7,355′= + , where cf ′  and cE  are in MPa. 

                                                           
1 For CSA A23.3-04 (Ref. [5]) and CSA A23.3-94 (Ref. [6]) 
2 For ACI 318-08 (Ref. [1]), ACI 318-05 (Ref. [2]) and ACI 318-02 (Ref. [3]); also see notes on ACI 318-08, 8.1.2 in Ref. [8] 
3 ACI 318-08, 10.2.1; ACI 318-05, 10.2.1; ACI 318-02, 10.2.1; CSA A23.3-04, 10.1.1; CSA A23.3-94, 10.1.1 
4 ACI 318-08, 10.2.2; ACI 318-05, 10.2.2; ACI 318-02, 10.2.2; CSA A23.3-04, 10.1.2; CSA A23.3-94, 10.1.2 
5 ACI 318-08, 10.2.3; ACI 318-05, 10.2.3; ACI 318-02, 10.2.3 
6 CSA A23.3-04, 10.1.3; CSA A23.3-94, 10.1.3 
7 ACI 318-08, 10.2.6, 10.2.7; ACI 318-05, 10.2.6, 10.2.7; ACI 318-02, 10.2.6, 10.2.6 
8 CSA A23.3-04, 10.1.1; CSA A23.3-94, 10.1.1 
9 For consistency with Eq. 10-1 and 10-2 in ACI codes (Refs. [1], [2], [3]) and with Eq. 10-10 in CSA codes (Refs. [5], [6]) 
10 ACI 318-08, 10.2.4; ACI 318-05, 10.2.4; ACI 318-02, 10.2.4; CSA A23.3-04, 8.5.3.2; CSA A23.3-94, 8.5.3.2 
11 ACI 318-08, 10.2.5; ACI 318-05, 10.2.5; ACI 318-02, 10.2.5; CSA A23.3-04, 10.1.5; CSA A23.3-94, 10.1.5 
12 ACI 318-08, 8.5.1; ACI 318-05, 8.5.1; ACI 318-02, 8.5.1 
13 ACI 318M-08, 8.5.1; ACI 318M-05, 8.5.1; ACI 318M-02, 8.5.1 
14 CSA A23.3-04, 8.6.2.3, Eq. 8.1 and CSA A23.3-94, 8.6.2.3, Eq. 8-6 (with γc = 2400 kg/m3) 
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3. The modulus of elasticity of reinforcing steel15, sE , is taken as 29,000 ksi (200,000 MPa) unless 
otherwise specified by the user. 
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Figure 2-1 Analysis of Reinforced Section 

4. The ratio of the concrete compression block depth to the distance between the extreme compression fiber 
and the neutral axis, 1β , is computed as follows (unless otherwise specified by the user): 

1 c0.65 1.05 0.05f 0.85′≤ β = − ≤ , for the ACI code16 where cf ′  is in ksi, 

1 c0.65 (149 f ) /140 0.85′≤ β = − ≤ , for the ACI code17 where cf ′  is in MPa. 

For the CSA standard18, 1 c0.97 0.0025f 0.67′β = − ≥ , where cf ′  is in MPa. 

5. Stress in the reinforcement is computed based on the strain at the centroid of each reinforcing bar. 

6. All moments are referenced to the geometric centroid of the gross concrete section (neglecting the 
reinforcement). 

7. For the ACI codes, the nominal (unreduced) capacity of the section is first computed. Then, the nominal 
capacity is reduced to the design capacity using the strength reduction factor, φ , the value of which is 
calculated based on the net tensile steel strain, tε , in the following way19:  

• For columns with spiral reinforcement per ACI 318-08 

( )
t

t y s
y y t

y s

t y y

0.9 if 0.005 (tension controlled sec tion)
0.20 f / E

0.75 if f / E 0.005 (transition sec tion)
0.005 f / E

0.75 if f / E (compression controlled sec tion)

ε ≥⎧
⎪ ε −⎪φ = + < ε <⎨ −⎪

ε ≤⎪⎩

 

                                                           
15 ACI 318-08, 8.5.2; ACI 318-05, 8.5.2; ACI 318-02, 8.5.2; ACI 318M-05, 8.5.2; ACI 318M-02, 8.5.2; CSA A23.3-04, 8.5.4.1; CSA 
A23.3-94, 8.5.4.1 
16 ACI 318-08, 10.2.7.3; ACI 318-05, 10.2.7.3; ACI 318-02, 10.2.7.3 
17 ACI 318M-08, 10.2.7.3; ACI 318M-05, 10.2.7.3; ACI 318M-02, 10.2.7.3 
18 CSA A23.3-04, 10.7.1(c); CSA A23.3-94, 10.7.1(c) 
19 ACI 318-08, 9.3.2, 10.3.3, 10.3.4; ACI 318-05, 9.3.2, 10.3.3, 10.3.4; ACI 318-02, 9.3.2, 10.3.3, 10.3.4 



 

Method of Solution 2-3 

• For columns with spiral reinforcement per ACI 318-05 and ACI 318-02 

( )
t

t y s
y y t

y s

t y y

0.9 if 0.005 (tension controlled sec tion)
0.20 f / E

0.70 if f / E 0.005 (transition sec tion)
0.005 f / E

0.70 if f / E (compression controlled sec tion)

ε ≥⎧
⎪ ε −⎪φ = + < ε <⎨ −⎪

ε ≤⎪⎩

 

• For other columns per ACI 318-08, ACI 318-05, and ACI 318-02 

( )
t

t y s
y y t

y s

t y y

0.9 if 0.005 (tension controlled sec tion)
0.25 f / E

0.65 if f / E 0.005 (transition sec tion)
0.005 f / E

0.65 if f / E (compression controlled sec tion)

ε ≥⎧
⎪ ε −⎪φ = + < ε <⎨ −⎪

ε ≤⎪⎩

 

• For the CSA standards, the program calculates the factored resistance directly using the factored 
compressive concrete strength20, c cf ′φ , and the factored forces in reinforcement bars21, s iSφ . The 
material resistance factor for concrete, cφ , equals 

c

0.6 for CSA A23.3-94
0.65 for CSA A23.3-04 (cast-in-place)
0.70 for CSA A23.3-04 (precast)

⎧
⎪φ = ⎨
⎪
⎩

 

The material resistance factor for steel, sφ , is equal to 0.90. 

Additionally, the design axial capacity (for all ACI and CSA standards) is capped22 at 0.85 of the 
maximum axial capacity for sections with spiral reinforcement or at 0.80 for sections with tie 
reinforcement. 

 
Figure 2-2 Reduction factors for Flexure and Axial Loads per ACI code 

8. In the investigation mode the program will calculate capacity for any provided area of reinforcement. 
However, if the reinforcement area falls below the code-specified23 minimum of 0.01 times the gross 
area, Ag, then two options, Architectural or Structural, are available. 

By default Architectural option is selected for which the capacity of the section is reduced. For the ACI 
codes, the reduction results from multiplying the maximum concrete stress, cf ′ , by the ratio of 

                                                           
20 CSA A23.3-04, 8.4.2, 16.1.3; CSA A23.3-94, 8.4.2 
21 CSA A23.3-04, 8.4.3; CSA A23.3-94, 8.4.3 
22 ACI 318-08, 10.3.6; ACI 318-05, 10.3.6; ACI 318-02, 10.3.6; CSA A23.3-04, 10.10.4; CSA A23.3-94, 10.10.4 
23 ACI 318-08, 10.9.1; ACI 318-05, 10.9.1; ACI 318-02, 10.9.1; CSA A23.3-04, 10.9.1; CSA A23.3-94, 10.9.1 
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reinforcement area to 0.01Ag. This produces the same effect as reducing the effective concrete area24 to 
achieve ratio of reinforcement area to gross concrete area equal to 0.01. For the CSA standards25, the 
factored axial and flexural resistances are multiplied by ratio ( )t0.5 1 / 0.01+ ρ  for the 04 edition and 

t / 0.01ρ  for the 94 edition. 

For Structural option, the section is treated “as is” without any reductions in capacity. This option is 
provided for informational purposes only, since per all codes supported by spColumn, capacity of 
compression members with reinforcement area less than 0.01Ag has to be reduced and areas below 
0.005Ag are not allowed. 

9. Under the Design option, the reinforcement ratio cannot be less than 1.0% if Structural column type is 
selected in design criteria and 0.5% in case of Architectural column type. For Architectural type, the 
capacity of the designed column is reduced as described above. Additionally, User Defined type is 
provided in the design criteria, which allows designs with reinforcement ratios not less than 0.1%. No 
reduction in capacity is applied for User Defined column type. 

10. Maximum reinforcement ratio26 for Structural and Architectural options in both Investigation and 
Design modes is 8%. For User Defined type in the Design mode the maximum reinforcement ratio is set 
to 20%. 

B – Conventions 
1. Positive axial forces are compressive and negative axial forces are tensile. 

2. Looking in plan at the section with z-axis pointing outwards, the positive x-axis points to the right and 
the positive y-axis points up. For this section, vectors of positive bending moments have the same 
orientation as their corresponding axes x and y. Thus, a positive bending moment about the x-axis, Mx, 
produces tension at the top face of the section and compression at the bottom face. A positive bending 
moment about the y-axis, My, produces tension at the left face of the section and compression at the right 
face. 

3. If service loads are input, moment loads at the upper (top) and lower (bottom) ends of the column are 
needed. Top and bottom moment loads of opposite signs produce single curvature bending. Top and 
bottom moment loads of the same sign produce double curvature bending. 

Positive moment loads at the upper end of the column coincide with positive bending moments. 
However, at the lower end, positive moment loads produce effects opposite to positive bending moments. 
Therefore spColumn changes the sign of the service moment at the lower end to convert it from a 
moment load to a bending moment. 
Axial load is assumed to be constant so it is input only as for the upper end where positive axial load 
coincides with positive axial force. 

 

                                                           
24 ACI 318-08, 10.8.4; ACI 318-05, 10.8.4; ACI 318-02, 10.8.4 
25 CSA A23.3-04, 10.10.5; CSA A23.3-94, 10.10.5 
26 ACI 318-08, 10.9.1; ACI 318-05, 10.9.1; ACI 318-02, 10.9.1; CSA A23.3-04, 10.9.2; CSA A23.3-94, 10.9.2 
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Figure 2-3 Positive axial force and bending moments (internal forces) 

4. If factored loads are input, they are considered to be applied at a section pointing upwards so that they 
have the same orientations as positive axial force and positive bending moments. 

 
Figure 2-4 Positive moment loads (external forces) 

5. The convention for the slenderness input of beam and column dimensions and their orientation is 
presented in Figure 2-5. Beams above the columns are shown. Same convention applies to beam below 
the column. 

 
Figure 2-5 Slenderness Input Convention 

C – Section Investigation 
1. The computations performed when investigating a section depend on the selected load mode: 

a) Factored loads – for the axial load of each load point, the moment capacity and the ratio of design-
to-applied moment are computed. For a biaxial run, the computed Mx and My moment capacities are 
at the same angle as that produced by the applied Mx and My moments. In uniaxial case the program 
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also reports the depth of neutral axis and maximum steel strain corresponding to the calculated 
moment capacity. For the ACI code, the value of strength reduction factor is also reported. 
spColumn allows defining up to 50 load combinations. The user has full control over the 
combinations. The program contains predefined (built into the program) default primary load 
combinations for the supported codes. These default combinations are created when starting a new 
project. The default load combinations of the Dead (D), Live (L), Wind (W), Earthquake (E) and 
Snow (S) loads considered by the program are shown below. For the ACI 318-02, 05, and 08 
codes27: 
U1 = 1.4D 
U2 = 1.2D + 1.6L + 0.5S 
U3 = 1.2D +1.0L + 1.6S 
U4 = 1.2D + 0.8W + 1.6S 
U5 = 1.2D +1.0L + 1.6W + 0.5S 
U6 = 0.9D + 1.6W 
U7 = 1.2D – 0.8W + 1.6S 
U8 = 1.2D +1.0L – 1.6W + 0.5S 
U9 = 0.9D – 1.6W 
U10 = 1.2D +1.0L +1.0E – 0.2S 
U11 = 0.9D +1.0E 
U12 = 1.2D +1.0L – 1.0E + 0.2S 
U13 = 0.9D – 1.0E 
For the CSA A23.3-94 code28: 
U1 = 1.25D 
U2 = 1.25D + 1.5L 
U3 = 1.25D + 1.5L + 1.5S 
U4 = 1.25D + 1.05L + 1.05W 
U5 = 1.25D + 1.05L + 1.05W + 1.05S 
U6 = 1.25D + 1.5W 
U7 = 0.85D + 1.5W 
U8 = 1.0D +1.0L + 1.0E 
U9 = 1.0D +1.0L + 1.0E + 1.0S 
U10 = 1.0D + 1.0E 
U11 = 1.25D + 1.05L – 1.05W 
U12 = 1.25D + 1.05L – 1.05W + 1.05S 
U13 = 1.25D – 1.5W 
U14 = 0.85D – 1.5W 
U15 = 1.0D + 1.0L – 1.0E 
U16 = 1.0D + 1.0L – 1.0E + 1.0S 
U17 = 1.0D – 1.0E 
For the CSA A23.3-04 code29: 
U1 = 1.4D 
U2 = 1.25D + 1.5L 
U3 = 1.25D + 1.5L + 0.5S 
U4 = 1.25D + 1.5L + 0.4W 
U5 = 1.25D + 1.5L – 0.4W 

                                                           
27 ACI 318-08, 9.2; ACI 318-05, 9.2; ACI 318-02, 9.2; 
28 CSA A23.3-94, 8.3.2 (conservatively assuming storage and assembly occupancies) 
29 CSA A23.3-04, 8.3.2; CSA A23.3-04, Annex C, Table C1; NBCC 2005 [7], Table 4.1.3.2 
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U6 = 0.9D + 1.5L 
U7 = 0.9D + 1.5L + 0.5S 
U8 = 0.9D + 1.5L + 0.4W 
U9 = 0.9D + 1.5L – 0.4W 
U10 = 1.25D + 1.5S 
U11 = 1.25D + 0.5L + 1.5S 
U12 = 1.25D + 0.4W + 1.5S 
U13 = 1.25D – 0.4W + 1.5S 
U14 = 0.9D + 1.5S 
U15 = 0.9D + 0.5L + 1.5S 
U16 = 0.9D + 0.4W + 1.5S 
U17 = 0.9D – 0.4W + 1.5S 
U18 = 1.25D + 1.4W 
U19 = 1.25D + 0.5L + 1.4W 
U20 = 1.25D + 1.4W + 0.5S 
U21 = 1.25D – 1.4W 
U22 = 1.25D + 0.5L – 1.4W + 0.5S 
U23 = 1.25D – 1.4W + 0.5S 
U24 = 0.9D + 0.5L + 1.4W 
U25 = 0.9D + 0.5L + 1.4W 
U26 = 0.9D + 1.4W + 0.5S 
U27 = 0.9D – 1.4W 
U28 = 0.9D + 0.5L – 1.4W 
U29 = 0.9D – 1.4W + 0.5S 
U30 = 1.0D + 1.0E 
U31 = 1.0D + 0.5L + 1.0E + 0.25S 
U32 = 1.0D – 1.0E 
U33 = 1.0D + 0.5L – 1.0E + 0.25S 

b) Service loads – the program calculates the factored loads using the input load combinations. If 
slenderness effects are to be checked and the column is found to be slender, the applied moments are 
magnified according to Procedures E and F. For each calculated factored load, the same 
computations described in (a) above are performed.  

c) Control points – for several key points on the interaction diagram, the program calculates axial load 
and moment capacity together with the neutral axis depth and maximum steel strain corresponding to 
the respective moment capacity. For ACI code, strength reduction factor is also reported. The 
following key points are used by the program: maximum compression, allowable compression, point 
where steel stress is zero, point where steel stress is 0.5 yf , balanced point, pure flexure and 
maximum tension. For ACI code, an additional control point is introduced where maximum steel 
strain is equal to 0.005 (tension control limit). 

d) Axial loads – for each input axial load, the program calculates the positive and negative moment 
capacities together with the corresponding neutral axis depths and maximum steel strains. For ACI 
code, strength reduction factors are also reported. 

2. The program also computes the interaction diagram (uniaxial runs) or the three-dimensional failure 
surface (biaxial runs) of the input section. The values of maximum compressive axial load capacity and 
maximum tensile load capacity are computed. These two values set the range within which the moment 
capacities are computed for a predetermined number of axial load values.  

a) For uniaxial runs, positive and negative moment capacities about only the selected axis are 
computed. Moment capacities about the orthogonal axis are ignored. To compute the moment 
capacity at a certain level of axial load, the neutral axis angle is held constant, parallel to the selected 
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axis. The neutral axis depth is adjusted to arrive at the desired axial load capacity. This is done for 
all the predetermined values of axial load.  

b) For biaxial runs, the same predetermined values of axial load are utilized. For each level of axial 
load, the section is rotated in 10-degree increments from 0 degrees to 360 degrees and the Mx and My 
moment capacities are computed. Thus for each level of axial load, an Mx-My contour is developed. 
Repeating this for the entire range of axial loads, the three-dimensional failure surface is computed. 

Also for each point on the interaction diagram or on the three-dimensional failure surface, the program 
calculates the location of the neutral axis (expressed in terms of depth and angle of the neutral axis), 
maximum steel strain, and (for ACI codes only) the strength reduction factor. 
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Figure 2-6 Interaction Surface for Combined Axial Load and Biaxial Bending 

D – Section Design 
1. Based on the specified minimum, maximum and increment specified for the section and the reinforcing 

bars, the program selects the smallest section with the least amount of reinforcement for which the load-
moment capacity exceeds the applied loads. If service loads are input, they are factored using the input 
load combinations. Depending on the design criteria the user selects, the least amount of reinforcement 
the program searches for means either the smallest number of bars or the smallest steel area. 
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2. The program starts the design by trying the smallest section (minimum dimensions) and the least amount 
of reinforcing bars. The program verifies that the ratio of provided reinforcement is always within the 
specified minimum and maximum ratios. Furthermore, unless otherwise specified by the user30, the bar 
spacing is always kept greater than or equal to the larger of 1.5 times the bar diameter or 1.5 in. [40 mm] 
for ACI31 and 1.4 times the bar diameter or 1.2 in [30 mm] for CSA32. 

3. A section fails the design if, for the design axial load, the ratio of design-to-applied moment is less than 
1.0 (unless otherwise specified in the Design Criteria dialog box).  

4. Once a section passes the design, its capacity is computed and the calculations explained in Procedure C 
above are performed. 

E – Moment Magnification at Ends of Compression Member 
This procedure accounts for moment magnification due to second-order effects at ends of columns in sway 
frames33.  

1. If properties of framing members are input, spColumn computes the sway condition effective length 
factor, sk , using the following simplified equations34:  

if both ends are restrained and m 2ψ < , ( )s m mk 0.05 20 1 1.0= − ψ + ψ ≥ , 

if both ends are restrained and m 2ψ ≥ , s mk 0.9 1 1.0= + ψ ≥ ,  

if the upper end is hinged, s Bk 2 0.3= + ψ , 

if the lower end is hinged, s Ak 2 0.3= + ψ , 

if both ends are hinged, sk 30= . 

Where ψ  is the ratio of ( )cEI /Σ l  of columns to ( )EI /Σ l  of beams in a plane at one end of the column, 

Aψ  and Bψ are the values of ψ  at the upper end and the lower end of the column, respectively, and mψ  
is the average of Aψ  and Bψ .  

An end is determined to be hinged if its ψ  is very large. This happens in the case where ( )EI /Σ l  of 

beams is too small (or zero) relative to the ( )cEI /Σ l  of columns at that end. In this case, the program 
outputs 999.9 for the value of ψ . The moment of inertia used in computing ψ  is the gross moment of 
inertia multiplied by the cracked section coefficients35 (specified in the Slenderness Factors dialog box).  

2. For the ACI code36, slenderness effects will be considered if uk / r 22.0≥l . For the CSA standards, all 
sway columns are designed for slenderness effects. 

3. If the ratio uk / rl  exceeds 100, slenderness effects cannot be accounted for using moment magnification 
procedure37. A more exact method must be used. In this case, the program issues a warning message and 
aborts design or investigation procedure except for calculations per ACI 318-08 where limit of 

uk / r 100<l  does not explicitly apply and the program continues calculations after showing the warning 
message. 

                                                           
30 The user may select spacing greater than the default value to take into account tolerances for reinforcement placement (see ACI 117-
06, Ref [4]) and other project specific considerations. 
31 ACI 318-08, 7.6.3; ACI 318-05, 7.6.3; ACI 318-02, 7.6.3 
32 CSA A23.3-04, Annex A, 6.6.5.2; CSA A23.3-94, Annex A, A12.5.2 
33 ACI 318-08, 10.10.7; ACI 318-05, 10.13; ACI 318-02, 10.13; CSA A23.3-04, 10.16, CSA A23.3-94, 10.16 
34 ACI 318-05, R10.12.1; ACI 318-02, R10.12.1 
35 ACI 318-08, 10.10.4.1; ACI 318-05, 10.11.1, 10.13.1; ACI 318-02, 10.11.1, 10.13.1; CSA A23.3-04, 10.14.1.2, 10.16.1; CSA A23.3-
94, 10.14.1, 10.16.1 
36 ACI 318-08, 10.10.1; ACI 318-05, 10.13.2; ACI 318-02, 10.13.2 
37 ACI 318-05, 10.11.5; ACI 318-02, 10.11.5; CSA A23.3-04, 10.13.2; CSA A23.3-94, 10.13.2 
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4. Factored moments, ns,topM  and ns,botM , due to dead, live, and snow loads assumed to cause no 
appreciable sidesway38, are calculated at the top and bottom ends of the column. 

5. Factored moments, s,topM  and s,botM , due to lateral loads (wind and earthquake) assumed to cause 
appreciable sidesway39, are calculated at the top and bottom ends of the column. 

6. Flexural stiffness EI is calculated as40: 

c g s se

ds

0.2E I E I
EI

1
+

=
+ β

 

where cE  is the modulus of elasticity of concrete, sE  is the modulus elasticity of steel, gI  is the gross 

moment of inertia of the concrete section, seI  is the moment of inertia of reinforcement. Assuming that 
shear due to lateral loads is not sustained in most frames41, the dsβ  is taken as zero (with the exception of 
strength and stability of the structure as a whole under factored gravity loads described in Step 11). 

7. The critical buckling load, cP , is computed as42: 

( )

2

c 2
u

EIP
k l
π

= . 

8. The sway moment magnification factor, sδ , is computed as43: 

s
u

k c

1.0 1.0P1
P

δ = ≥
Σ

−
φ Σ

, 

where the stiffness reduction factor, kφ , is equal to 0.75. 

uPΣ  is taken as the factored axial load for the load combination under consideration times the 
ratio u uP / PΣ , i.e.44 ( )u u u uP P P PΣ = Σ . 

cPΣ  is taken as the critical buckling load for the load combination under consideration times the ratio 

c cP / PΣ , i.e. ( )c c c cP P P PΣ = Σ . 

kφ  and the ratios u uP / PΣ  and c cP / PΣ  may be modified using the Slenderness Factors input box.  

9. The magnified moments at the top and bottom ends of the compression member are computed as45: 

top ns,top s s,topM M M= + δ , 

bot ns,bot s s,botM M M= + δ . 

10. The smaller and the larger factored end moments are then determined based on absolute values of 
magnified top and bottom end moments 

                                                           
38 ACI 318-08, 2.1; ACI 318-05, 2.1; ACI 318-02, 10.0; CSA A23.3-04, 2.3; CSA A23.3-94, 10.0 
39 ACI 318-08, 2.1; ACI 318-05, 2.1; ACI 318-02, 10.0; CSA A23.3-04, 2.3; CSA A23.3-94, 10.0 
40 ACI 318-08, 10.10.6 Eq. 10-14; ACI 318-05, 10.12.3 Eq. 10-11; ACI 318-02, 10.12.3. Eq. 10-10; CSA A23.3-04, 10.16.3.2, 10.15.3 
Eq. 10-18; CSA A23.3-94, 10.16.3.2, 10.15.3.1 Eq. 10-18 
41 ACI 318-08, R10.10.7.4; ACI 318-05, R10.13.4.1, R10.13.4.3; ACI 318-02, R10.13.4.1, R10.13.4.3; Ref. [9] pp 586 (first paragraph 
from the bottom) 
42 ACI 318-08, 10.10.6 Eq. 10-13; ACI 318-05, 10.12.3 Eq. 10-10; ACI 318-02, 10.12.3 Eq. 10-10; CSA A23.3-04, 10.16.3.2, 10.15.3.1 
Eq. 10-17; CSA A23.3-94, 10.16.3.2, 10.15.3 Eq. 10-17 
43 ACI 318-08, 10.10.7.4 Eq. 10-21; ACI 318-05, 10.13.4.3 Eq. 10-18; ACI 318-02, 10.13.4.3 Eq. 10-18; CSA A23.3-04, 10.16.3.2 
Eq. 10-23; CSA A23.3-94, 10.16.3.2 Eq. 10-23 
44 To minimize required input, the program uses one value of ratio ΣPu / Pu for all load combinations. However, the ratio can vary 
depending on the combination under consideration. In this case, it will be conservative to use the highest value of the ratio. 
45 ACI 318-08, 10.10.7; ACI 318-05, 10.13.3; ACI 318-02, 10.13.3; CSA A23.3-04, 10.16.2; CSA A23.3-94, 10.16.2 
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bot top bot
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top top bot
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While design codes define moment M2 as always positive and the sign of moment M1 depending on 
single or double curvature bending46, spColumn retains actual signs of moments M1 and M2. This 
revision ensures proper comparison against negative and positive moment capacities of unsymmetrical 
sections (see Figure 2-7). 

11. Strength and stability of the structure as a whole under factored gravity loads47 is ensured by checking 
that the value of the moment magnification factor, δs. is positive and does not exceed 2.5.  

The program performs this check for all load combinations that include only gravity loads with the 
exception of the ACI 318-08 code for which the check is not performed and CSA A23.3-94 where the 
check is performed only for the load combination of 1.25 dead load plus 1.5 live load plus (1.5 snow or 
0.0 snow), if this combination is present (default). The dβ  factor for the load combination under 
consideration is equal to the maximum sustained factored axial load to the maximum factored axial load. 

F – Moment Magnification along Length of Compression Member 
This procedure accounts for moment magnification due to second-order effect along the length of 
compression members that are part of either nonsway48 or sway frames49. In nonsway frames, moment 
magnification along length is neglected by the program if the condition in Step 3 below is satisfied.  

In sway frames designed per ACI 318-02/05 and CSA A23.3-94/04, the magnification along the length is 
neglected if50: 

u

u

c g

35
r P

f A

≤

′

l . 

By rearranging and introducing u c gk P /(f A )′ ′= , this condition can be succinctly expressed as uk / r 35′ ≤l . 

For columns designed per ACI 318-08 code, moment magnification along length is to be considered for all 
slender compression members, i.e. columns in either nonsway or sway frames regardless of the uk / r′l  ratio. 
Since various published examples of columns designed per ACI 318-08 do not combine moment 
magnification at ends and along length of columns in sway frames51, spColumn optionally allows not 
considering moment magnification along the length of a column in a sway frame based on engineering 
judgment of the user. 

When moment magnification along the length of a compression member is considered, the following 
procedure is followed: 

1. The effective length factor, k, is either entered by the user or calculated by the program. The value of k 
must be between 0.5 and 1.0 for moment magnification along length and the recommended52 value is 1.0. 

                                                           
46 ACI 318-08, 2.1; ACI 318-05, 2.1; ACI 318-02, 10.0; CSA A23.3-04, 2.3; CSA A23.3-94, 10.0 
47 ACI 318-05, 10.13.6; ACI 318-02, 10.13.6; CSA A23.3-04, 10.16.5; CSA A23.3-94, 10.16.5 
48 ACI 318-08, 10.10.6; ACI 318-05, 10.12; ACI 318-02, 10.12; CSA A23.3-04, 10.15; CSA A23.3-94, 10.15 
49 ACI 318-08, 10.10.2.2; ACI 318-05, 10.13.5; ACI 318-02, 10.13.5; CSA A23.3-04, 10.16.4; CSA A23.3-94, 10.16.4 
50 ACI 318-05, Eq. 10-19; ACI 318-02, Eq. 10-19; CSA A23.3-04, Eq. 10-25; CSA A23.3-94, Eq. 10-25 
51 See Example 11.2 in Ref. [8], Example 12.4 in Ref. [10], and Example 12.3 in Ref. [9] 
52 ACI 318-08, 10.10.6.3, R10.10.6.3; ACI 318-05, 10.12.1; ACI 318-02, 10.12.1; CSA A23.3-04, 10.15.1; CSA A23.3-94, 10.15.1 
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Smaller values can be used if justified by analysis. If properties of framing members are input, spColumn 
computes the effective length factor, k, as the smaller of53:  

( )A B0.7 0.05 1.0+ ψ + ψ ≤  

min0.85 0.05 1.0+ ψ ≤  

Where ψ  is the ratio of ( )cEI /Σ l  of columns to ( )EI /Σ l of beams in a plane at one end of the column, 

Aψ  and Bψ  are the values of ψ  at the upper end and the lower end of the column, respectively, and 

minψ  is the smaller of Aψ  and Bψ . Moments of inertia used in computing ψ  factors are gross moments 
of inertia multiplied by the cracked section coefficients54 (specified in the Slenderness Factors dialog 
box).  

2. Moments at column ends, M1 and M2, are calculated, where M1 is the moment with the smaller absolute 
value and M2 is the moment with the larger absolute value. For columns in nonsway frames, the end 
moments will be equal to the factored applied first order moment. For columns in sway frames, the end 
moments will be the moments M1 and M2 calculated in the procedure for moment magnification at ends 
of compression member. While design codes define moment M2 as always positive and the sign of 
moment M1 depending on single or double curvature bending55, spColumn retains actual signs of 
moments M1 and M2 to ensure proper comparison of resulting magnified moments against negative and 
positive moment capacities of unsymmetrical sections (see Figure 2-7). This revised interpretation does 
not affect results of the moment magnification along length procedure because the procedure relies on 
the M1/M2 ratio. spColumn follows the code definition which assumes the ratio to be positive if the 
member is bent in single curvature and negative if bent in double curvature. If both moments are equal to 
zero, the program conservatively assumes the ratio of 1 2M / M 1.0= . 

3. Second-order effects along length for columns in nonsway frames can be ignored if:  

u 1

2

k M34 12 40
r M

≤ − ≤
l  for ACI codes56, 

and 

( )
u 1 2

f c g

k 25 10(M M )
r P f A

−
≤

′

l
,  for the CSA standards57 

where ul  is the unsupported column length, gr I / A=  is the radius of gyration, and the ratio 1 2M / M  

is always taken as greater than or equal to –0.5.  

4. If the ratio uk / rl  exceeds 100, slenderness effects cannot be accounted for using moment magnification 
procedure58. A more exact method must be used. In this case, the program issues a warning message and 
aborts design or investigation procedure except for calculations per ACI 318-08 where limit of 

uk / r 100<l  does not explicitly apply and the program continues calculations after showing the warning 
message. 

5. The factor mC  is computed as59: 

1
m

2

MC 0.6 0.4 0.4
M

= + ≥ . 

                                                           
53 ACI 318-05, R10.12.1; ACI 318-02, R10.12.1 
54 ACI 318-08, 10.10.4.1; ACI 318-05, 10.11.1, 10.12.1; ACI 318-02, 10.11.1, 10.12.1; CSA A23.3-04, 10.14.1.2, 10.15.1; CSA A23.3-
94, 10.14.1, 10.15.1 
55 ACI 318-08, 2.1; ACI 318-05, 2.1; ACI 318-02, 10.0; CSA A23.3-04, 2.3; CSA A23.3-94, 10.0 
56 ACI 318-08, 10.10.1; ACI 318-05, 10.12.2; ACI 318-02, 10.12.2 
57 CSA A23.3-04, 10.15.2; CSA A23.3-94, 10.15.2 
58 ACI 318-05, 10.11.5; ACI 318-02, 10.11.5; CSA A23.3-04, 10.13.2; CSA A23.3-94, 10.13.2 
59 ACI 318-08, 10.10.6.4; ACI 318-05, 10.12.3.1; ACI 318-02, 10.12.3.1; CSA A23.3-04, 10.15.3.2; CSA A23.3-94, 10.15.3.1 
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If 1 2M M 0= = , the program assumes Cm to be equal to60 1.0. This is consistent with the assumption 
made above (in Step 2). 

6. The sustained load factor dnsβ  is computed as the ratio of maximum factored axial sustained load to the 
maximum factored axial load for the load combination under consideration for compression members 
either in nonsway61 or sway62 frames. The value of dnsβ  is not taken greater than 1.0. 

7. Flexural stiffness EI  is computed as63: 

c g s se

dns

0.2E I E I
EI

1
+

=
+ β

 

where cE  is the modulus of elasticity of concrete, sE is the modulus of elasticity of steel, gI is the gross 

moment of inertia of the concrete section, and seI  is the moment of inertia of reinforcement. 

8. The critical buckling load, cP , is computed as64: 

2

c 2
u

EIP
(k )
π

=
l

. 

9. The magnification factor for moment along length, δ , is computed as65: 

m

u

k c

C 1.0P1
P

δ = ≥
−

φ

, 

where the stiffness reduction factor, kφ , is equal to 0.75 (may be modified using the Slenderness Factors 
input box) and uP  is the factored axial load for the load combination under consideration. 

10. The moment due to minimum eccentricity, mine , is computed as66: 

min u minM P e= , where 

mine 0.6 0.03 h= + , with h in inches, 

mine 15 0.03 h= + , with h in mm, 

and h  is the section dimension (diameter for circular sections) in the direction being considered.  

11. The factored magnified moment along the length of a compression member, cM , is the larger67 of 2Mδ  
and minMδ . The program also calculates moment Mc based on the smaller end moment, M1, to account 
for scenario when M1 and M2 are of different sign (double curvature bending). For an unsymmetrical 
section, the smaller moment, M1, may govern the design when the moment capacity on the negative side 
of the interaction diagram is smaller than the moment capacity on the positive side (see Figure 2-7). 

                                                           
60 ACI 318-08, 10.10.6.5; ACI 318-05, 10.12.3.2; ACI 318-02, 10.12.3.2 
61 ACI 318-08, 10.10.6.2; ACI 318-05, 10.11.1; ACI 318-02, 10.0; CSA A23.3-04, 2.3; CSA A23.3-94, 10.0 
62 ACI 318-08, 10.10.2.2, 10.10.6.2; ACI 318-05, 10.13.5; ACI 318-02, 10.13.5; CSA A23.3-04, 10.14.1.3(a), 10.16.4; CSA A23.3-94, βd 
definition (a) in 10.0, 10.16.4 
63 ACI 318-08, 10.10.6.1 Eq. 10-14; ACI 318-05, 10.12.3 Eq. 10-11; ACI 318-02, 10.12.3. Eq. 10-10; CSA A23.3-04, 10.15.3 Eq. 10-18; 
CSA A23.3-94, 10.15.3.1 Eq. 10-18 
64 ACI 318-08, 10.10.6 Eq. 10-13; ACI 318-05, 10.12.3 Eq. 10-10; ACI 318-02, 10.12.3 Eq. 10-10; CSA A23.3-04, 10.15.3.1 Eq. 10-17; 
CSA A23.3-94, 10.15.3 Eq. 10-17 
65 ACI 318-08, 10.10.6 Eq. 10-12; ACI 318-05, 10.12.3 Eq. 10.9; ACI 318-02, 10.12.3 Eq. 10.9; CSA A23.3-04, 10.15.3.1 Eq. 10-16; 
CSA A23.3-94, 10.15.3 Eq. 10-16 
66 ACI 318-08, 10.10.6.5; ACI 318-05, 10.12.3.2; ACI 318M-05, 10.12.3.2; ACI 318-02, 10.12.3.2; ACI 318M-02 10.12.3.2; CSA 
A23.3-04, 10.15.3.1; CSA A23.3-94, 10.15.3. 
67 ACI 318-08, 10.10.6.5; ACI 318-05, 10.12.3.2; ACI 318-02, 10.12.3.2; CSA A23.3-04, 10.15.3.1; CSA A23.3-94, 10.15.3 
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Figure 2-7 Case of unsymmetrical section bent in double curvature (M1 and M2 of different sign) 

with the smaller end moment, M1, governing the design 

G – Ratio of Moments Due To Second-Order Effects to Moments Due To First-Order Effects 
For calculations in accordance with ACI 318-08 the value of total magnified moment including second-order 
effects (combined magnification at ends and along length of compression member) cannot exceed 1.4 times 
the corresponding moment due to first order effects68. Columns with second-order moment to first-order 
moment ratios exceeding 1.4 do not meet ACI 318-08 requirements. 

The ratio of second-order moment, M2nd, to first-order moment M1st is calculated for both values (i =1, 2) of 
magnified moment along length, Mci

, i.e. based on M1 and M2: 
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Cutoff value of Mmin is applied to Mui
 in order to avoid unduly large ratios in cases where Mui

 moments are 
smaller than Mmin. 

If only magnification at ends is considered (i.e. when user chooses to bypass provision 10.10.2.2 of ACI 318-
08 and ignores second order effects along the length of a compression member in a sway frame), the ratio of 
second-order moment, M2nd, to first-order moment, M1st, is calculated at both ends (i =1, 2) as: 

i

i i
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1st u ins is

M M MM
M M M M

+ δ
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+
 

where Mi are the magnified end moments M1 and M2, and Mui
 are the corresponding factored applied moment 

composed of the part that causes no appreciable sidesway, Mins, and the part that causes appreciable sidesway, 
Mis. If both M2ndi

 and M1sti
 moments are equal to zero, the program will report the ratio equal to 1.0. If only 

M1sti
 moment is equal to zero, the program will report the ratio as a large value. 

                                                           
68 ACI 318-08, 10.10.2.1 
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Chapter 3  – spColumn Interface 
spColumn Interface 

Main Window 
Most windows have certain elements in common, such as a title bar and menus. Not all windows, however, 
have every element. To learn more about how to use window elements, refer to your Microsoft Windows 
manual. The following is a list of the spColumn window components. 

 

Control-Menu Box: 
The Control-menu box is located in the upper-left corner of the window and includes commands for sizing, 
moving, enlarging, restoring, and closing the window, as well as switching to other applications. To access 
the Control-menu box using the mouse, click the left mouse button on the box; using the keyboard, press 
ALT+‘ ‘(space). 

Title Bar:  
The Title bar displays the name of the application (spColumn in this case), along with the name of the current 
data file in use. If the data have not been saved into a file, the word Untitled is displayed in the Title bar.  

Menu Bar:  
The Menu bar is located directly below the Title bar. It lists the available menus. A menu contains a list of 
commands or actions you can execute.  

Tool Bar:  
The Tool bar is located directly below the Menu bar. It contains a collection of buttons (or icons) that provide 
a shortcut to accessing the menu commands. The Tool bar buttons can only be accessed using the mouse.  

Information Bar:  
The Information bar is located on the left side of the spColumn window. The top part displays the column 
cross section. The bottom part is a list of selected input data echo.  
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Graphics Area:  
The Graphics area covers most of the window. This is where the interaction diagram is shown.  

Status Bar:  
The Status bar is located along the bottom of the window. It displays important information such as units, 
design code, cursor position, and helpful messages. 

File Menu 
The File menu is used for working with data files, printing results, and exiting the program.  

New (CTRL+N) 
Clears any input data and returns the data to the default values so that a 
new data file may be input. 

Open (CTRL+O) 
Opens an existing spColumn data file.  

Save (CTRL+S) 
Saves the changes you have made to the current data file under that 
same filename.  

Save As 
Names or renames a data file.  

Import 
Reads geometry, reinforcement or loads data from an ASCII (TXT) file, or imports section geometry and 
reinforcement from a DXF file. 

Export  
Exports interaction diagram and 3D failure surface to Comma-Separated Values (CSV) files (readable by 
most spreadsheet programs) or Tab-Delimited Text (TXT) files. Exports a column section to Drawing 
Exchange Format (DXF) file (readable by most CAD programs). Exports graphical report (screen printout) to 
Enhanced Metafile Format (EMF) file (readable by most graphics and word processing programs). 

Revert  
Discards any changes to the data and returns to the last version of saved data. This option will only be 
available if the file has been modified since the last file save.  

Print Results 
Displays Print dialog box and prints the results in the text form to the selected printer. 

Print Screen (CTRL+P) 
Displays Print dialog box and prints the results similarly as they appear on the screen. 

Recent Data File List 
Provides quick access to up to four recently open data files. 

Exit  
Quits the spColumn program. If you have made any changes to your data and have not saved them, spColumn 
will prompt you whether you want to save or abandon any changes you have made before you exit. 
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Input Menu  
The Input menu includes commands used to input the data needed to define a problem.  

General Information  
Input labels to identify the input and select from several options that control the run.  

Material Properties  
Input the material properties for concrete and reinforcement.  

Section  
Rectangular: Input the dimensions of a rectangular section. 

Circular: Input the dimension of a circular section. 

Irregular: Execute spSection to define an irregularly shaped section. See Chapter 6. 

Reinforcement  
All Sides Equal: Input a reinforcement pattern in which all the bars are of one size, and the number of bars is 
the same on all four sides of a rectangular layout or are equally spaced for a circular layout. Available for 
rectangular and circular sections. 

Equal Spacing: Input a reinforcement pattern in which all bars are of one size and are uniformly spaced on 
all four sides of a rectangular layout. Available for rectangular sections only. 

Sides Different: Input a reinforcement pattern in which each one of the four sides of a rectangular section has 
a certain number of bars and a certain bar size. Available for rectangular sections only. 

Irregular Pattern: Input a reinforcement pattern in such a way that bars of any size can be placed anywhere 
within the column section. 

Confinement: Input confinement-related data such as the capacity reduction factors and the size of ties 
associated with the longitudinal bar size. 

Design Criteria: Input parameters that govern the design of the section such as column type, minimum and 
maximum reinforcement ratio, bar selection criterion, minimum clear spacing, and design/required ratio. 

Slenderness  
Design Column: Input data needed for slenderness related to the column being considered. 

Column Above/Below: Input data needed for slenderness related to the columns above and below the design 
column. 

X-Beams: Input data needed for slenderness related to beams perpendicular to the x-axis framing into the 
design column. 

Y-Beams: Input data needed for slenderness related to beams perpendicular to the y-axis framing into the 
design column. 

Factors: Input factors that affect slenderness calculations. 

Loads  
Factored: Input factored axial loads and moments. This command is available for non-slender columns only. 

Service: Input service-level (dead, live, wind, earthquake, and snow) axial loads and moments about the 
active axis. Moments are input at the top and at the bottom of the column. This command must be used for 
slender columns. 
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Control Points: If chosen, the program will compute key points on the interaction diagram. In addition, the 
splice regions are shown on the interaction diagram. This option is available for short (non-slender) columns 
under the investigation option only and for uniaxial runs only. 

Axial Loads: Input a group of axial loads with an initial value, a final value, and an increment. This 
command is available for uniaxial short (non-slender) columns only. 

Load Combinations: Input the load factors and combinations used to combine the service loads.  

Flip/Rotate Section  
Flip an unsymmetrical section about an axis or rotate an irregular section (created in spSection). 

Solve Menu  
The Solve menu contains the command used to perform the design or investigation 
and options that control inclusion of nominal capacity calculations, tracing through 
the design process, and sending the output to a text file.  

Execute (F5)  
Executes the solver.  

Include Nominal Diagram 
Toggles INCLUDE NOMINAL DIAGRAM option on and off. 

Design Trace  
Toggles DESIGN TRACE option on and off.  

Results File  
Toggles RESULTS FILE option on and off. 

View Menu 
The View menu commands used to customize the display screen to suit your viewing needs, view the 
interaction diagram at a given angle, view the contour for a given axial load, superimpose an interaction 
diagram or a contour from another run, and view the results file.  

Redraw  
Redraws the displayed diagrams or contours. 

Copy Diagram to Clipboard (CTRL+C) 
Copies the displayed diagram or contour to clipboard so that in can be 
pasted in other applications. 

Information Bar  
Shows or hides the Information bar.  

Tool Bar  
Shows or hides the Tool bar.  

Status bar  
Shows or hides the Status bar.  

Grid  
Shows or hides the grid.  
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Mx-My Diagram  
View a contour of the failure surface sliced at a constant axial load.  

P-M Diagram - Full 
View an interaction diagram sliced at a constant (Mx, My) angle drawn for both positive and negative 
moments. 

P-M Diagram - M positive 
View an interaction diagram sliced at a constant (Mx, My) angle drawn for the positive moments only. 

P-M Diagram - M negative 
View an interaction diagram sliced at a constant (Mx, My) angle drawn for the negative moments only. 

Next Load (Ctrl + Arrow Up) 
View an Mx-My interaction diagram for the factored load next to the one displayed currently on the 
interaction diagram. 

Previous Load (Ctrl + Arrow Up) 
View an Mx-My interaction diagram for the factored load previous to the one displayed currently on the 
interaction diagram. 

Next Angle 
View a P-M interaction diagram at the (Mx, My) angle corresponding to factored load next to the one 
currently in the graphics area. 

Previous Angle 
View a P-M interaction diagram at the (Mx, My) angle corresponding to factored load previous to the one 
currently in the graphics area. 

Show Load Point Labels 
Show/Hide Load Point labels of factored loads input. 

Show Splice Lines 
Show the P-M splice lines corresponding to fs = 0 and fs = 0.5fy. 

Show Nominal Diagram 
Show nominal (unfactored) capacity interaction diagram in addition to the design (factored) capacity 
interaction diagram. Available only when Include Nominal Diagram option is selected in the Solve menu. 

Superimpose  
Superimpose a diagram from a previously saved run over the current diagram.  

Results (F6) 
View the results file after a successful run has been performed with the Solve | Results File option ON. 

Options 
The Options menu contains commands used to view or change spColumn’s default 
settings and reinforcement bar set.  

Startup Defaults 
View or Edit application startup default settings. 
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Reinforcement 
View or Edit reinforcing bar set. 

Help Menu  

spColumn Help 
Lists all the available help topics about the program.  

spColumn Manual  
Opens spColumn Manual in the default PDF viewer.  

Command Line Help 
Displays help on how to use command line parameters for running spColumn in batch mode. 

Check for Updates 
Checks if a newer version of the program is available. Internet connection is required. 

About spColumn 
Shows the version number of the program, the licensing information, and the copyright information. In the 
case of a trial license, the expiration date is given as well as the locking code which is needed to obtain a 
standalone license. 
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Operating the Program 

This chapter is divided into sections that follow the order in which commands and options appear in the 
program. 

Creating New Data File  
When spColumn is first loaded, the program is ready to obtain input for a new file. The data will not have a 
file name associated with it; therefore, Untitled appears in the Title bar.  

• Select File | New. This clears the screen and returns to the default settings of the program. If existing data 
have been changed prior to selecting the New command, spColumn asks if you want to save the data. At 
any time after starting a new file, use the File | Save As command to give the file a name. 

Opening Existing Data File 
You can open spColumn data files that were previously saved to disk. spColumn reads files that have been 
saved in binary format (with COL extension) or text input format (with CTI extension).  

• Select File | Open. A dialog box appears. 

• All files with the COL extension contained in the current drive and directory are displayed in the FILE 
NAME list box. 

• To open a file that exists in another drive or directory, select the drive or directory you want from the 
Drives drop-down list or the Directories list box respectively. 

• To open a file in spColumn Text Input (CTI) format69, use FILE TYPE list box to select this type. 

• From the FILE NAME list box, select the file to be opened, or simply type its name in the text box.  

• Choose the OK button. 

 

                                                           
69 See Appendix for description of the CTI format 
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Saving Data 

To save the data with the same file name:  
At anytime while editing a data file that has previously been saved under a file name, choose File | Save to 
save the changes under the same file name. Selecting the File | Save command before giving the data file a 
name displays the Save As dialog box.  

To give the data a new or different file name or to change input file format:  
• Select File | Save As. A dialog box appears. 

• All files with COL extension contained in the current drive and directory are displayed in the FILE NAME 
list box. 

• To save the file to a drive or directory other than the default, select a different drive from the Drives 
drop-down list or a different directory from the Directories list box. 

• Use FILE TYPE list box to select either spColumn Input File (COL) or spColumn Text Input File (CTI). 

• In the FILE NAME text box, type a new file name. If no file extension is specified, an extension will be 
appended to the specified file name based on the selected file type. 

• Choose the OK button. 

 

Importing 

Importing Data 
Geometry, reinforcement or load data may be imported from a text file. The import file must be saved in pure 
ASCII (text) format.70 

• Select File | Import | Import Data… or press CTRL + I keyboard shortcut to 
display IMPORT DATA dialog box. 

• Select the type of data you want to import: SERVICE LOADS, FACTORED LOADS, 
REINFORCEMENT OR GEOMETRY. 

• Choose the OK button. The Open Import file box is displayed. 

                                                           
70 See Appendix for description of the import file format 
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• All files with the TXT extension contained in the current drive and directory are displayed in the FILE 
NAME list box. 

• To open a file that exists in another drive or directory, select the drive or directory you want from the 
Drives drop-down list or the Directories list box respectively. 

• From the File Name list box, select the file to be opened, or simply type its name in the text box.  

• Choose the OPEN button. 

Importing DXF Files 
• Select File | Import | Import DXF…. to display Open Import file box. 

• All files with the DXF extension contained in the current drive and directory are displayed in the FILE 
NAME list box. 

• To open a file that exists in another drive or directory, select the drive or directory you want from the 
Drives drop-down list or the Directories list box respectively. 

• From the File Name list box, select the file to be opened, or simply type its name in the text box.  

• Choose the OPEN button. 

• The DXF IMPORT LAYER SELECTION dialog box is displayed. 

 
• Type the layer name (default is “0”) to import the section from and click the OK button. To search the 

whole file, press the SKIP button or provide an empty name. 

If the DXF file (or selected layer) contains a closed polyline entity (either LWPOLYLINE or POLYLINE) it 
will be interpreted as the section outline. If multiple closed polylines are present then the fist two will be 
automatically recognized as the outline and the opening and the rest will be ignored.  

Reinforcing bars are derived from DXF circle entities (CIRCLE). If no closed polylines are present then the 
first circle entity will be interpreted as a circular shape of the column and the rest will be interpreted as 
reinforcing bars. 

Dimensions of imported entities will be automatically converted to current project units based on DXF header 
variable $INSUNITS. 

Exporting Data 
Once a successful run has been performed you may export points from the 
interaction diagram or 3D failure surface to a Comma-Separated Values (CSV) file 
or to a Tab Delimited Text file (TXT). These files can be read by most spreadsheet 
and mathematical programs where data produced by spColumn can be further 
analyzed and processed as needed by the user. Coordinates of the points (P, Mx, 
My) are saved together with corresponding location of the neutral axis (depth and 
angle), maximum steel strain, and (for ACI code) strength reduction factor. The 
column section can be exported to a file in Drawing Exchange Format (DXF) format that is readable by most 
CAD programs. A graphical report can be exported to a file in Enhanced Metafile Format (EMF) that is 
readable by most graphics and word processing programs. The file will include column section, column 
information, and the interaction diagram currently displayed on the screen presented the same way as in the 
printout created by the default printer using the File | Print Screen command.  

• Select File | Export | Factored Interaction Diagram to export P-M or Mx-My diagram currently 
displayed on the screen. 
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• To export 3D failure surface (biaxial runs only) select File | Export | Factored 3D Failure Surface. 

• Select File | Export | Nominal Interaction Diagram to export nominal (unfactored) P-M or Mx-My 
diagram corresponding to the one currently displayed on the screen. 

• To export nominal (unfactored) 3D failure surface (biaxial runs only) select File | Export | Nominal 
3D Failure Surface. 

• To export column section to DXF file select File | Export | Column Section to DXF File. 

• To export graphical report to EMF file select File | Export | Graphical Report to EMF File. 

• For interaction diagrams and 3D failure surface, use FILE TYPE list box to select either Comma-Separated 
Values (CSV) file or Tab Delimited Text file (TXT). For sections, only DXF format is available and for 
graphical reports, only EMF format is available. 

• In the FILE NAME text box, type the file name. If no file extension is specified, an extension will be 
appended to the specified file name based on the selected file type. 

• Choose the OK button. 

 

Printing Results 
Once a successful run has been performed you may print the displayed diagram using File | Print Screen 
command. If the Solve | Results File option was selected you may print the results file using File | Print 
Results. spColumn sends the printout to the printer selected in the Print dialog box.  

• Select File | Print Results or File | Print Screen. A dialog box appears. 

• Select the printer to send the results to. 

• Use Print dialog controls to set up the printer options. 

• Choose the OK button to start the printing or choose the CANCEL to terminate the print job. 
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General Information 
The General Information command allows you to define or change options that 
will affect the rest of the input.  

• Select Input | General Information. A dialog box appears. 

• Enter the PROJECT, COLUMN, and ENGINEER labels.  

• Select the units of measure, ENGLISH or METRIC.  

• Select the axis about which the column capacity is to be computed: 
ABOUT X-AXIS, ABOUT Y-AXIS, or BIAXIAL.  

• Select the design code to conform to: ACI 318-08, ACI 318-05, ACI 318-
02, CSA A23.3-04 or CSA A23.3-04.  

• Choose a run option: INVESTIGATION or DESIGN.  

• Specify whether slenderness effects are to be considered or not by 
checking either YES or NO under the CONSIDER SLENDERNESS? option.  

• Choose the OK button. 

Material Properties 
• Select Input | Material Properties. A dialog box appears. 

• Enter the concrete compressive strength, f’c under STRENGTH, f’c. The modulus of elasticity, Ec, under 
ELASTICITY, Ec; the constant stress intensity, fc at the maximum usable strain used to calculate the force 
on concrete, under MAX STRESS, fc; the factor used to determine the depth of the stress block, under 
BETA(1); and the maximum usable strain at the extreme concrete compression fiber, at the ULTIMATE 
STRAIN are automatically computed and displayed. Modify any of the values if different that computed.  

• For the reinforcing steel, enter the yield strength, fy under STRENGTH, fy, and the modulus of elasticity, Es 
under the ELASTICITY, Es. 

• Choose the OK button. 
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Section / Rectangular 

Input for the Investigation Option: 
• Select Input | Section | Rectangular. A dialog box appears. 

• Enter the width and depth of the rectangular section using WIDTH (ALONG X) and 
DEPTH (ALONG Y) respectively. Note that width is measured along the x-axis and 
depth is measured along the y-axis. 

• Choose the OK button. 

Input for the Design Option:  
• Select Input | Section | Rectangular. A dialog box appears. 

• Enter the starting and ending values for each dimension (width and 
depth) along with an increment for each dimension under START, END 
and INCREMENT columns along WIDTH (ALONG X) and DEPTH (ALONG 
Y). Note that the starting and ending values may be the same (in which 
case the increment must be zero).  

• Choose the OK button. 

Section / Circular 

Input for the Investigation Option:  
• Select Input | Section | Circular. A dialog box appears. 

• Enter the diameter of the column section.  

• Choose the OK button.  

Input for the Design Option:  
• Select Input | Section | Circular. A dialog box appears. 

• Enter the starting and ending values the diameter along with an 
increment. Note that the starting and ending values may be the same (in 
which case the increment must be zero). 

• Choose the OK button. 

Reinforcement / All Sides Equal 
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The Input | Reinforcement | All Sides Equal command allows you to enter the total number of bars in the 
column section. The program attempts to divide the bars equally between the four sides of a rectangular 
layout then equally space them on each side. Corner bars are associated with the top and bottom sides, and if 
the total number of bars is not a multiple of four, the top and bottom sides get the extra bars. For a circular 
layout, the program attempts to equally space the bars.  

Input for the Investigation Option: 
• Select Input | Reinforcement | All Sides Equal. A dialog box 

appears.  

• Enter the total number of bars in the section. It must be at least 4 and 
must be a multiple of 4 for a rectangular layout. For a circular layout it 
can be any number not less than 4. 

• Select the bar size. 

• Enter the clear cover and specify whether it is to the transverse (ties) or to the longitudinal bars.  

• Select a bar layout, CIRCULAR or RECTANGULAR. The default is Circular for a circular section and 
Rectangular for a rectangular section.  

• Choose the OK button.  

Input for the Design Option 
• Select Input | Reinforcement | All Sides Equal. A dialog box 

appears. 

• Enter the minimum and maximum total number of bars in the 
section (must be at least 4 and must be a multiple of 4 for a 
rectangular layout).  

• Select the minimum and maximum bar sizes along with the clear 
cover.  

• Enter the clear cover and specify whether it is to the transverse 
(ties) or to the longitudinal bars.  

• Select a bar layout, Circular or Rectangular. The default is Circular for a circular section and Rectangular 
for a rectangular section.  

Reinforcement / Equal Spacing 
The Input | Reinforcement | Equal Spacing command allows you to enter the total number of bars in the 
column section. The program attempts to place the bars equally spaced on all four sides of a rectangular 
layout. Corner bars are associated with the top and bottom sides and if the total number of bars is not a 
multiple of 4, the program does not accept the input.  

Input for the Investigation Option:  
• Select Input | Reinforcement | Equal Spacing. A dialog box 

appears. 

• Enter the total number of bars in the section NO. OF BARS. (Must be 
at least 4 and a multiple of 4).  

• Select the bar size.  

• Enter the clear cover and specify whether it is to the transverse (ties) 
or to the longitudinal bars.  

• Choose the OK button.  
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Input for the Design Option:  
• Select Input | Reinforcement | Equal Spacing. A dialog box appears.  

 
• Enter the minimum and maximum total number of bars in the section under MINIMUM and MAXIMUM 

corresponding to NO. OF BARS. (must be a multiple of 4). 

• Select the minimum and maximum bar sizes.  

• Enter the clear cover and specify whether it is to the transverse (ties) or to the longitudinal bars.  

• Choose the OK button.  

Reinforcement / Sides Different 

Input for the Investigation Option:  
• Select Input | Reinforcement | Sides Different. A dialog box 

appears.  

• Enter the number of bars to be placed on each of the top, bottom 
(on the top and bottom, number of bars needs to be at least 2), 
left and right sides (on the left and right, the number of bars may 
be any number) of the rectangular section. Note that corner bars 
are associated with the top and bottom sides.  

• Select the bar size and enter the clear cover for each of the top, 
bottom, left and right sides of the section.  

• Specify whether the clear cover entered is to the transverse (ties) 
or to the longitudinal bars.  

• Choose the OK button.  

Input for the Design Option: 
• Select Input | Reinforcement | Sides Different. A dialog box 

appears.  

• In the Top and Bottom group, enter the minimum and maximum 
total number of bars to be placed on the top and bottom sides, 
along with the bar size and the clear cover. The number of bars 
must be greater than 4 and a multiple of 2. Corner bars are 
associated with the top and bottom sides. 

• Select the minimum and maximum bar size and enter the clear 
cover.  

• Repeat the steps above for the Left and Right sides.  

• Specify whether the clear cover entered is to the transverse (ties) 
or to the longitudinal bars.  

• Choose the OK button.  
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Reinforcement / Irregular Pattern 
The Input | Reinforcement | Irregular Pattern command allows you to specify any number of bars (up to 
10,000) to be placed anywhere within the column section. Each bar may have any cross-sectional area. This 
command is available with the Investigation option only. 

• Select Input | Reinforcement | Irregular Pattern. If the section is 
irregular, The spSection window, where the section reinforcement may 
be graphically input, is displayed. Otherwise, a dialog box appears. 

• Enter the bar area, along with its x- and y-coordinates.  

• Choose the INSERT button. The data are added to the list box.  

• Repeat the steps above for each entry.  

• To edit an entry, select it from the list box, modify its values in the text 
boxes, and choose the MODIFY button. To change the area for several 
bars at once, select those bars from the list box, enter the new area in the 
AREA text box, and choose MODIFY.  

• To delete a bar entry, select it from the list box and choose the DELETE 
button.  

• Choose the OK button.  

Reinforcement / Confinement 
• Select Input | Reinforcement | Confinement. A dialog box appears.  

• Select the type of bar confinement: TIED (default), SPIRAL, or Other. The capacity reduction factors 
change depending on the selection.  

• To modify the capacity reduction factors, choose OTHER for confinement type.  

For the ACI code:  

Phi(a) is the reduction factor for allowable compression,  

Phi(b) is the strength reduction factor for tension controlled failure, 

Phi(c) is the reduction factor for compression controlled failure. 

For the CSA code: 

Phi(a) is the reduction factor for allowable compression, 

Phi(s) is the material resistance factor for steel, 

Phi(c) is the material resistance factor for concrete. 

• Specify the tie size associated with the particular longitudinal bar 
sizes. The code requirements are used as defaults. 

• Choose the OK button.  

Note that if confinement is selected as TIED or SPIRAL than the program will automatically adjust the factors 
when the user changes the design code. However, if OTHER confinement is selected, the factors will not be 
adjusted. 

Reinforcement / Design Criteria 
• Select Input | Reinforcement | Design Criteria. A dialog box appears. This command is available with 

the Design option only. 
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• Specify whether the column is to be considered STRUCTURAL 
(default), ARCHITECTURAL, or OTHER. Notice that the minimum and 
maximum reinforcement ratios change depending on the selection. 

• Choose whether bar selection is to be based on MINIMUM NUMBER OF 
BARS (default) or on MINIMUM AREA OF STEEL. 

• To modify the limiting reinforcement ratios, choose OTHER. Enter the 
minimum and maximum reinforcement ratios in the corresponding 
text boxes.  

• Enter the minimum clear bar spacing and the design-to-required ratio.  

• Choose the OK button.  

Slenderness / Factors 
• Select Input | Slenderness | Factors. A dialog box appears. Note: this 

command is available for slender columns only.  

• The default values, per the design code, for the stiffness reduction factor (used 
to compute the moment magnification factors) and the cracked section 
coefficients for beams and columns are displayed. To modify these values, 
select the USER-DEFINED option and enter your values.  

• Choose the OK button.  

Slenderness / Design Column 
• Select Input | Slenderness | Design Column. A dialog box appears. The x-axis or y-axis data groups 

may be disabled depending on the active run axis. Note: this command is available for slender columns 
only. 

• Enter the clear column height in the corresponding text box. 

• Specify whether the column is braced against sidesway or not by selecting or clearing the NONSWAY 
FRAME option.  

• For a sway column, enter the ratio of the sum of 
the critical load of all story columns to the critical 
load of the column under consideration, 
(SUM PC)/PC. Also, enter the ratio of the sum of 
the factored axial load of all story columns to the 
factored axial load of the column under 
consideration, (SUM PU)/PU. Check 2ND ORDER 
EFFECTS ALONG LENGTH option to consider 
2nd order effects along length. Note: this option is 
available for ACI 318-08 code only. For more 
information, see discussion in section F – Moment 
Magnification along Length of Compression 
Member in Chapter 2– Method of Solution. 

• In the EFFECTIVE LENGTH FACTORS group, specify 
whether the k factor(s) are to be user-input or 
computed by the program, by selecting the 
corresponding option. 

• If you chose INPUT K FACTORS, enter the effective 
length factors for nonsway and sway conditions, 
k(ns) and k(s), respectively. 
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• Repeat the steps above for each active axis. 

• Choose the OK button. 

Slenderness / Columns Above and Below 
• Select Input | Slenderness | Columns Above/Below. A dialog box appears. Note: this command is 

available for slender columns only for which the COMPUTE k FACTORS option is selected in the DESIGN 
COLUMN dialog box.  

 
• In the COLUMN ABOVE group, specify whether or not a column above the design column exists, by 

selecting or clearing the NO COLUMN SPECIFIED OPTION.  

• If a column above exists; enter the center-to-center height, the width (along the x-axis), the depth (along 
the y-axis), the concrete compressive strength, and the concrete modulus of elasticity of the column 
above in the corresponding text boxes. For circular sections, enter zero for the DEPTH and input the 
section diameter in the WIDTH box. If zero is entered for both Width and Depth, the dimensions of the 
design column will be automatically used. 

• Repeat the same for the column below or, if the column above and the column below are the same, 
choose the COPY TO COLUMN BELOW button. 

• Choose the OK button.  

Slenderness / X-Beams 
• Select Input | Slenderness | X-Beams. A dialog box appears. Beams defined using this command span 

perpendicular to the x-axis. Note: this command is available for slender columns only for which the 
COMPUTE K FACTORS option is selected in the DESIGN COLUMN dialog box and the RUN AXIS is BIAXIAL 
or uniaxial ABOUT X-AXIS. 

• From the BEAM LOCATION group, choose the appropriate option. 
The data group below updates depending on the selection.  

• For the selected beam, specify whether or not a beam exists, by 
selecting or clearing the NO BEAM SPECIFIED OPTION.  

• If a beam exists; enter the center-to-center span length, width, 
depth, concrete compressive strength, concrete modulus of 
elasticity, and moment of inertia (if different than computed) of the 
beam.  

• Repeat the steps above for the beams ABOVE RIGHT, BELOW LEFT, 
and BELOW RIGHT.  

• Choose the OK button.  
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Slenderness / Y-Beams 
• Select Input | Slenderness | Y-Beams. A dialog box appears. Beams defined using this command span 

perpendicular to the y-axis. Note: this command is available for slender columns only for which the 
COMPUTE K FACTORS option is selected in the DESIGN COLUMN dialog box and the RUN AXIS is BIAXIAL 
or uniaxial ABOUT Y-AXIS.  

• From the BEAM LOCATION group, choose the appropriate option. 
The data group below updates depending on the selection.  

• For the selected beam, specify whether or not a beam exists, by 
selecting or clearing the NO BEAM SPECIFIED OPTION.  

• If a beam exists; enter the center-to-center span length, width, 
depth, concrete compressive strength, concrete modulus of 
elasticity, and moment of inertia (if different than computed) of the 
beam.  

• Repeat the steps above for the beams ABOVE RIGHT, BELOW LEFT, 
and BELOW RIGHT.  

• Choose the OK button.  

Loads / Factored  
Whether designing or investigating a short (non-slender) column, factored loads consisting of applied axial 
loads and moments about the active axis may be input.  

• Select Input | Loads | Factored. A dialog box appears.  

• Enter the factored axial load in the LOAD text box.  

• Depending on the active axis, enter the factored moment about the x-axis 
– X-MOMENT, the factored moment about the y-axis – Y-MOMENT, or 
both.  

• Choose the INSERT button. The data are added to the list box.  

• Repeat the steps above for each factored load entry.  

• To edit an entry, select it from the list box, modify its values in the text 
boxes, and choose the MODIFY button.  

• To delete an entry, choose it from the list box and choose the DELETE 
button.  

• Choose the OK button.  

Loads / Service 
When designing or investigating a short or slender column, service level loads consisting of dead, live, lateral 
(wind and earthquake), and snow axial loads and moments at both column ends about the active axis may be 
input. These loads are then factored and combined based on the load combinations.  

• Select Input | Loads | Service. A dialog box appears.  

• For each of the load cases: Dead, Live, Wind, Earthquake (EQ), and Snow, enter the axial load and the 
applicable moment (about x or y) at the column top and bottom.  
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• Enter the percentage of the sustained part of the load in each load case (by default only Dead Load is 
assumed to be 100% sustained). These percentages will be used to arrive at sustained axial load ratio βdns 
to calculate moment magnification factor along length of the column71. 

• Choose the INSERT button. The data are added to the list box.  

• Repeat the steps above for each entry.  

• To edit an entry, select it from the list box, modify its values in the text boxes, and choose the MODIFY 
button.  

• To delete an entry, choose it from the list box and choose the DELETE button. 

• Choose the OK button.  

 

Load / Control Points 
A non-slender column may be investigated without inputting any loads. The capacity of the section is 
computed along with other important information. This command is not available for slender columns or 
under the Design option.  

• Select Input | Loads | Control Points. 

In the output file, key points on the interaction diagram are listed. For each point, the axial load and 
bending moment capacities, along with the corresponding neutral axis depth, are listed. 
For a biaxial run, these points are listed for bending about positive and negative X and Y axes.  
For uniaxial runs, the bar-splice regions are indicated on the interaction diagram.  

Loads / Axial Loads 

                                                           
71For moment magnification at ends of a column in a sway frame, the value of βds is assumed to be zero and is not affected by sustained 
load factors (see Chapter 2, Page 2-10, Footnote 41) 
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When investigating a short column (uniaxial runs only), grouped factored applied axial loads may be input. 
The corresponding moment capacity for each load is computed and output. This command is not available 
under the DESIGN option, for biaxial runs, or if the column is slender.  

• Select Input | Loads | Axial Loads. A dialog box appears.  

• To input a range of axial loads, enter the initial, final and increment 
values in the corresponding text boxes. To input a discrete (single) axial 
load, enter its value in the INITIAL text box, and enter zero in the FINAL 
and INCREMENT text boxes.  

• Choose the INSERT button. The data are added to the list box.  

• Repeat the steps above for each axial load entry you may have.  

• To edit an entry, select it from the list box, modify its values in the text 
boxes, and choose the MODIFY button.  

• To delete an entry, choose it from the list box and choose the DELETE 
button.  

• Choose the OK button.  

Loads / Load Combinations 
spColumn allows you to specify up to 50 load combinations. The 
service load input under the load cases (dead, live, wind, earthquake, 
and snow) are combined based on these combinations. A minimum of 
one combination must be input. 

• Select Input | Loads | Load Combinations. A dialog box appears. 
For a new file, the default combinations per the selected code are 
shown in the list box.  

• To add a new combination, enter the load factors or multipliers for 
each load case, DEAD, LIVE, WIND, Earthquake (EQ), and SNOW.  

• Choose the INSERT button. The data are added to the list box.  

• Repeat the steps above for each load combination. Up to fifty 
combinations may be defined.  

• To edit an entry, select it from the list box, modify its values in the 
text boxes, and choose the MODIFY button.  

• To delete an entry, choose it from the list box and choose the 
DELETE button.  

• Choose OK when done. 

Flipping / Rotating the Section 
This command is available for Irregular sections and for sections with Sides Different or Irregular 
reinforcement.  

• Select Input | Flip/Rotate Section. A dialog box appears.  

• Select one of the options: FLIP SECTION ABOUT X-AXIS, FLIP SECTION ABOUT 
Y-AXIS, or ROTATE SECTION. The last option is available for irregular 
sections only.  

• If ROTATE SECTION is selected, enter the angle of rotation (clockwise is 
positive).  
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• Choose the OK button.  

Executing a Run 

From the program 
• Select Solve | Results File. This is an option that may be turned ON or OFF by choosing it again. With 

this option ON, an output file will be created while the program is solving. The output file is a text file 
that contains an echo of the input along with slenderness calculation output, load combinations, and the 
critical points on the interaction diagram.  

• Select Solve | Include Nominal Diagram. This is an option that may be turned ON or OFF by choosing 
it again. With this option ON, calculations of nominal (unfactored) capacity interaction diagram will also 
be included in the calculations so that the nominal diagram can be viewed and exported in addition to the 
design (factored) capacity diagram. 

• Select Solve | Design Trace (design option only). This is an option that may by turned ON or OFF be 
choosing it again. With this option ON, if designing a column section, the program will pause at each 
cross section and reinforcement layout it tries, and display the cross section with its bars in the 
Information bar.  

• Select Solve | Execute. If more data are needed to solve the 
problem, an error box appears and you will be prompted for the 
required data. If all the needed data are input, the solver portion of 
spColumn will start executing. The Solving box appears with a 
progress indicator. Click Cancel to terminate the solution process. 
After a successful run, the interaction diagram or the contour plot 
is displayed in the Graphics area of the window.  

From command prompt 
spColumn run can also be executed from the command line prompt. Input data file, output data file, and run 
options can be passed to the program via parameters. For instance typing spColumn 
/i:Examples\Example01.col will run spColumn and solve the column define in input file 
Example01.col. 

 
Help on how to use command line parameters can be obtained by typing spColumn /? at the command 
prompt. 
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Viewing Results 
Once a successful run has been performed with the Solve | Results File option ON, you may view the results 
file.  

• Select View | Results. spColumn executes the spView program, an applet that enables viewing of text-
based files.  

• Use the scroll bars or the cursor keys to navigate through the file.  

• Select Exit to quit spView and return to spColumn. Changing the Startup Defaults 

Changing Startup Defaults 
You can change some default settings that spColumn uses when it is started or 
when the File | New command is executed.  

• Select Options | Startup Defaults. A dialog box appears. 

• Enter the full path of the directory to which spColumn defaults when 
opening a data file.  

• Select the system of units, design code, and reinforcement to be used as 
defaults whenever a new file is started.  

• Enter the name of the program to be used by spColumn when viewing 
results. By default, spColumn uses spView.  

• Enter the number of lines per page to be used in formatting the results file.  

• Choose the SAVE button to save these options in the registry.  

Changing Reinforcement Bar Set 
• Select Options | Reinforcement. A dialog box appears. 

To select a different set:  
• From the BAR SET drop-down list, select the set to be used. 
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• Choose the OK button. 

To create or modify a user-defined set 
• From the BAR SET drop-down list, select USER-DEFINED. The ADD, 

DELETE and MODIFY buttons are enabled.  

• To edit an entry, select it from the list box, modify its values, and choose 
the MODIFY button.  

• To delete an entry, select it from the list box and choose the DELETE 
button.  

• To add an entry, enter the bar size, diameter, area and unit weight in the 
corresponding text box, and choose the ADD button. The data are added to 
the list box.  

• A user-defined set may be saved to disk for use in other files. To do so, 
choose the SAVE button after inputting the bars. The bar set is saved to the 
file specified by the user. To retrieve a saved set, choose the READ button. 

• Choose the OK button.  

Superimposing Diagrams 
After executing a run and selecting the File | Save command, the program saves the diagram data in a 
separate file that has the same file name as the input file, with an IAD extension. If calculations of nominal 
interaction diagram are included, the program stores also the nominal diagram data in an additional IAD file 
named as the input file name suffixed with “-nominal.iad”. 

The IAD interaction diagram file may be later read by the program and two diagrams (of different files) may 
be superimposed for the purpose of comparison. Note that the RUN AXIS (uniaxial or biaxial) of the two files 
must be the same.  

• Select View | Superimpose option. The open dialog box appears.  

• All files with the IAD extension contained in the current drive and directory are displayed in the FILE 
NAME list box. To open a file that exists in another drive or directory, select the drive or directory you 
want from the DRIVES drop-down list or the DIRECTORIES list box respectively.  

• From the FILE NAME list box, select the file to be opened, or simply type its name in the text box.  

• Choose the OK button. If the data is successfully read, the diagram from the IAD file (shown dotted) is 
superimposed over the currently displayed diagram.  

• To clear the superimposed diagram, uncheck the View | Superimpose option.  

Viewing Diagrams 
By default, the program displays diagrams based on the design (factored) section capacity. Display of 
diagrams based on the nominal (unfactored) strength is controlled by the View | Show Nominal Diagram 
option which is available when calculations of nominal diagram are activated using the Solve | Include 
Nominal Diagram option. 

For a uniaxial run, the program computes and displays the P-M interaction diagram. For a biaxial run, the 
program computes the three-dimensional failure surface (P, Mx, My). The failure surface can be viewed in one 
of two ways: 

a) P-M interaction diagram (vertical slice at an angle measured from Mx)  
b) Mx-My contour curve (horizontal slice at a constant axial load). 

Whenever the mouse cursor moves over the Graph area, the axial load, moment, and eccentricity are 
displayed in the Status bar. 
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Viewing Interaction Diagram  
• Select View | P-M Diagram - Full. A dialog box appears.  

• You may also select View | P-M Diagram – M positive or View | P-
M Diagram – M negative to view the interaction diagram only for 
positive or negative moments. 

• Specify whether you want to enter an angle or the values of the 
moments that produce a view angle by selecting either the ANGLE or 
MOMENTS option, respectively. 

• If the ANGLE option was selected, select an angle from the list, use the 
scroll bar to pick an angle, or simply enter the value in the text box.  

• If the MOMENTS option was selected, enter the values of Mx and My 
which define the view angle. The value of that view angle is computed 
and shown in the ANGLE text box.  

• To display all load points and their numbers check the LIST POINT NUMBERS option. To display unique 
angle values only, leave the option unchecked. 

• Choose the OK button. 

• You may browse through the angles by using View | Next angle and View | 
Previous angle respectively.  

Viewing Contour 
• Select View | Mx-My Diagram. A dialog box appears. 

• Select an axial load from the list, use the scroll bar to pick a load, or simply enter 
the value in the text box. 

• To display all load points and their numbers check the LIST POINT NUMBERS 
option. To display unique axial load values only, leave the option unchecked. 

• Choose the OK button. 

• You may browse through the loads by using View | Next Load and View | Previous Load respectively. 

 
 



 

 

Chapter 5  – Examples 
Examples 

Example 1 – Capacity of a Square Column 
For a column section72 which is 16” x 16” and reinforced with 4-#8 bars, calculate the load moment 
capacities for the following load conditions: 

Case 1: Bar stress near tension face of member equal to zero, (fs = 0).  

Case 2: Bar stress near tension face of member equal to 0.5fy, (fs = 0.5fy)  

Case 3: At limit for compression controlled sections. (εs = 0.002) 

Case 4: At limit for tension controlled sections. (εs = 0.005) 

Given a concrete of 4000 psi and reinforcing steel of 60,000 psi. 

1. From the File menu, choose New. Any input data is cleared and the 
default values are restored.  

2. From the Input menu, choose General Information.  
• Input the PROJECT header.  

• Select English units and ACI 318-08 code.  

• Select About X-axis for run axis, Investigation for run option and No 
for Consider slenderness?  

• Choose OK.  

3. From the Input menu, choose Material Properties.  
• Accept the default properties as they match those in the problem statement  

• Choose OK. 

 
4. From the Input menu, choose Section | Rectangular.  

• For the section WIDTH (ALONG X), input 16 

• For the section DEPTH (ALONG Y), input 16. 

                                                           
72 Based on Example 6.4, pp 6-33 from Notes on ACI 318-08 Building Requirements for Structural Concrete with Design Applications, 
Edited by Mahmoud E. Kamara, Lawrence C Novak, and Basile G. Rabbat, Tenth Edition, 2008, Portland Cement Association. 



 

5-2 spSection Module 

• Choose OK. 

  
5. From the Input menu, choose Reinforcement | Equal Spacing.  

• Input 4-#8 bars under NO. OF BARS.  

• Input 1.5 in for the CLEAR COVER and select TRANSVERSE BARS. under COVER TO. 

• Choose OK. 

6. From the Input menu, choose Loads | Control Points.  
7. From the Solve menu, choose Execute.  

• The P-MX contour is displayed in the Graphics area.  

8. From the View menu, choose Results.  
• Page through the results file.  

• Choose File | Exit to quit the spView program and get back to spColumn.  

9. From the File menu, choose Print Results.  
• Select the printer to send the text results to. 

• Choose PRINT. 

10. From the File menu, choose Print Screen.  
• Select the printer to send the graphical results to. 

• Choose PRINT. 
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5-4 spSection Module 
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Example 2 – Investigation of a Slender Nonsway Column  
Determine the adequacy of a 4” x 20” column73 with 3-#11 bars on each 14” side in a nonsway frame with a 
clear height of 22’6”. Use k=1.0. 

The concrete used is 6000 psi and the reinforcing steel is 60,000 psi. 

The factored load values for the column under consideration are as follows: 

P (kip) 115 kips 

Top Muy (kip-ft) 279 ft-kips 

Bottom Muy (kip-ft) -279 ft-kips 

 

From the File menu, choose New. Any input data is cleared and the default 
values are restored.  

1. From the Input menu, choose General Information.  
• Input the PROJECT header.  

• Select ENGLISH units and ACI 318-08 code.  

• Select Biaxial for run axis, Investigation for run option and Yes for 
Consider Slenderness? 

• Choose OK.  

2. From the Input menu, choose Material Properties. 
• Input 4.5 for the CONCRETE STRENGTH. Change the REINFORCING STEEL STRENGTH to 50. Other 

properties are computed and will be accepted.  

• Choose Ok.  

 
From the Input menu, choose Section | Rectangular.  

• Input 20 and 14 for the section width (along X) and depth (along Y).  

• Choose OK. 

                                                           
73 Based on Example 15.8.5 from Reinforced Concrete Design by Chu-Kia Wang, Charles G. Salmon, and Jose A. Pincheira, Seventh 
Edition, 2007, John Wiley and Sons, Inc. 
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3. From the Input menu, choose Reinforcement | Sides Different.  

• Input 2-#11 bars for TOP and BOTTOM and 1-#11 for LEFT and RIGHT. Input 1.5 in for the cover 
and select LONGITUDINAL BARS.  

• Choose OK.  

4. From the Input menu, choose Slenderness | Design Column.  
• Input 22.5 for the column CLEAR HEIGHT.  

• Check NONSWAY FRAME and select INPUT ‘K’ FACTORS.  

• Choose OK. 

 
5.  From the Input menu, choose Loads | Service.  

 

• Under LIVE, input 71.875 for the AXIAL LOAD, 0 for the X-MOMENTS @TOP, 0 for the X-
MOMENTS @BOT, 174.375 for the Y-MOMENTS @TOP and -174.375 for the Y-MOMENTS 
@BOTTOM, respectively.  

• In column SUSTAINED LOAD keep default setting for dead load equal 100%. 

• Choose INSERT to add the entry to the list box.  

• Choose OK .  
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6. From the Input menu, choose Loads | Load Combinations.  

• If the list displays thirteen combinations, choose only the second load combination U2 and delete all 
the others by selecting them and using DELETE. Choose OK. 

 
7. From the Solve menu, choose Execute.  

• The solver of the program is started and, upon completion, displays the interaction diagram of the 
section with the load point plotted within the diagram.  

8. From the View menu, choose Results.  
• Page through the results file.  
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• Choose FILE | EXIT to quit the spView program and get back to spColumn.  

9. From the File menu, choose Print Results.  
• Select the printer to send the text results to. 

• Choose PRINT. 

10. From the File menu, choose Print Screen.  
• Select the printer to send the graphical results to. 

• Choose PRINT. 
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Example 3 – Design of a Slender Column in a Sway Frame 
Design a square column74 with a clear height of 16 ft. The column is sway and subjected to dead, live and 
wind loads as shown below. 

 Dead Live Wind 

P (kip) 380 140 0 

Top Mx (kip-ft) 32 20 50 

Bottom Mx (kip-ft) 54 36 50 

 

The column is to be checked for the following load combinations: 

U1 = 1.2 D + 1.6 L 
U2 = 1.2 D + 0.5 L + 1.6 W 

The calculations in the reference are done based on the load combination U2. 

In practice, the ratio ΣPc/ Pc would have to be calculated before the problem 
can be attempted, using a trial value of ΣPc/Pc. Here, the value of ΣPc/Pc used 
is 28.67 based on the reference value of Pc. There are 14 interior columns, 18 
exterior columns and 4 corner columns. Therefore, the value of 
ΣPu/Pu = 14 + 18 * 2/3 + 4 * 1/3 = 27.33 irrespective of the load combination 
being used. 
1. From the File menu, choose New. Any input data is cleared and the 

default values are restored.  
2. From the Input menu, choose General Information.  

• Input the PROJECT header.  

• Select English units and ACI 318-08 code.  

• Select About X-Axis for run axis, Design for run option and Yes for Consider slenderness? 

• Choose OK. 

3. From the Input menu, pick Material Properties.  
• Input 5 for the concrete strength. Other properties are computed and will be accepted.  

• Choose OK.  

 
4. From the Input menu, pick Section | Rectangular.  

                                                           
74 Based on Example 12.4, pp 409, from Structural Concrete: Theory and Design by M. Nadim Hassoun and Akthem Al-Manaseer, 
Fourth Edition, 2008, John Wiley and Sons, Inc. 
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• Input 18 and 18 for the WIDTH (ALONG X) and DEPTH (ALONG Y) under both START and END 
options.  

• Choose OK. 

 
5. From the Input menu, choose Reinforcement | Equal Spacing. 

• Input 8-#10 bars and 1.5 in for the cover and select TRANSVERSE BARS.  

• Choose OK. 

 
6. From the Input menu, choose Slenderness | Design Column. 

• Input 16 for the column CLEAR HEIGHT.  

• Check SWAY FRAME  

• Under SWAY CRITERIA, input 28.67 and 27.33 for the ΣPc/Pc and ΣPu/Pu, respectively.  

• Leave 2ND ORDER EFFECT ALONG LENGTH option checked (default) 

• Select COMPUTE ‘K’ FACTORS. 

• Choose OK. 

 
7. From the Input menu, choose Slenderness | Columns Above/Below. 
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• Clear the NO COLUMN SPECIFIED option.  

• Input 11 for the column height (center-to-center) under HEIGHT (C/C) and leave the other data as is.  

• Choose Copy to Column Below.  

• Choose OK. 

 
8. From the Input menu, choose Slenderness | X-Beams. 

• Choose ABOVE LEFT.  

• Clear the NO BEAM SPECIFIED option.  

• Input 20 for the span (center-to-center) under SPAN(C/C).  

• Input 0.00 and 0.00 for the WIDTH and DEPTH, respectively.  

• Input 21436.6 for the moment of inertia under INERTIA.  

• Leave the other data as it is.  

• Choose ABOVE RIGHT and click on COPY FROM BEAM LEFT.  

• Choose BELOW LEFT and click on COPY FROM BEAM ABOVE.  

• Choose BELOW RIGHT and click on COPY FROM BEAM ABOVE.  

• Choose OK.  

 
9. From the Input menu, choose Loads | Service. 

• Under DEAD, input 380, 32 and -54 for the AXIAL LOAD, X-MOMENTS and Y-MOMENTS 
respectively. 
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• Under LIVE, input 140, 20 and -36 for the AXIAL LOAD, X-MOMENTS and Y-MOMENTS, 
respectively.  

• Under WIND, input 0, 50 and -50 for the AXIAL LOAD, X-MOMENTS and Y-MOMENTS, 
respectively.  

 
• Under SUSTAINED LOAD keep the default settings of 100% for dead and 0% for all other load cases. 

• Choose INSERT to add the entry to the list box.  

• Choose OK. 

10. From the Input menu, choose Loads | Load Combinations.  
• If the list displays thirteen combinations, leave the first and 

second as they are. Delete the remaining combinations 
using DELETE.  

11. From the Solve menu, choose Execute.  
• The solver of the program is started and, upon completion, 

displays the interaction diagram of the section with the 
load points plotted within the diagram.  

12. From the View menu, choose Results.  
• Page through the results file.  

• Choose Exit to quit the spView program and get back to 
spColumn.  

13. From the File menu, choose Print Results.  
• Select the printer to send the text results to. 

• Choose PRINT. 

14. From the File menu, choose Print Screen.  
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• Select the printer to send the graphical results to. 

• Choose PRINT. 
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Example 4 – Investigation of Concrete Shear Wall  
Investigate the axial load and moment capacity of a shear wall75 for a given location of the neutral axis. Use 
4-ksi concrete and 60-ksi reinforcing steel. 

 
1. From the Start Menu, go to All Programs | StructurePoint | spColumn and run Design Assistant76. 
2. Design Assistant uses macros to export data to text files. If a macro warning is displayed when opening 

Design Assistant, make sure macros are enabled in order for the exporting function to work properly. 
3. Choose Example 4 Tab in the spreadsheet.  
4. Input the data shown below:  

• Under OVERALL SECTION WIDTH IN X, input 15.  

• Under OVERALL SECTION HEIGHT IN Y, input 144.  

• Under WEB WIDTH, input 12.  

• Under WEB HEIGHT, input 114.  

• Under NUMBER OF BOUNDARY BARS IN X, input 3.  

• Under NUMBER OF BOUNDARY BARS IN Y, input 3.  

• Under NUMBER OF WEB BARS PER LAYER, input 8.  

• Under WEB BAR SPACING, input 18.  

• Under COVER, input 2.5.  

• Under REINFORCEMENT AREA PER BOUNDARY BAR, input 0.79.  

• Under REINFORCEMENT AREA PER WEB BAR, input 0.31.  

                                                           
75 Based on Example 4-4, pp 333, from Seismic and Wind Forces Structural Design Examples by Alan Williams, Third Edition, 2007, 
International Code Council. 
76 Design Assistant is a Microsoft Excel spreadsheet that can be used to facilitate creation of spColumn text import files for a variety of 
sections including dumbbell shaped and C-shaped shear walls. 
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5. Press Export Geometry Button and Save Geometry File box appears. Save the file as Example4-

Geo.txt 

 
6. Press Export Reinforcement button and Save Reinforcement File dialog box appears. Save the file as 

Example4-Reinf.txt 
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7. Save and close the Design Assistant spreadsheet. 
8. From the Start Menu, go to All Programs | StructurePoint | spColumn and run spColumn 
9. From the File menu, choose New. Any input data is cleared and the default values are restored.  
10. From the File menu, choose Import | Import Data. Import Data (from text file) dialog box appears. 

Make sure that Geometry radio button is checked, choose OK 

 
11. Open Import File box appears. Select Example4-Geo.txt file and choose Open. The shear wall 

geometry appears on the spColumn screen. 

 
12. From the File menu, choose Import | Import Data. Import Data (from text file) box appears. Press 

Reinforcement radio button, then Choose OK  
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13. Open Import File box appears. Select Example4-Reinf.txt file and choose Open. The shear wall 
reinforcement appears on the spColumn screen as well. 

 
14. From the Input menu, choose General Information Tab. Input Project Information and leave all other 

options in their default settings of ACI 318-08 design code. Choose OK 

 
15. From the Input menu, choose the Material Properties tab. VERIFY CONCRETE STRENGTH, fc’, and 

REINFORCING STEEL STRENGTH, fy, values are entered as 4 ksi, and 60 ksi respectively. Leave all other 
options in their default settings. Choose OK  

 
16. From the Input menu, choose Reinforcement | Confinement Tab.  

• From the CONFINEMENT drop-down menu choose OTHER.  
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• Input AXIAL COMPRESSION (a) as 0.85. 

• Input COMPRESSION CONTROLLED FAILURE (c) as 0.7.  

• Leave all other options in their default settings. Choose OK 

 
17. From the Input menu, choose Loads | Axial Loads Tab.  

• Input 649.5 for the INITIAL LOAD. The initial axial load was selected 
through trial and error procedure in order to match neutral axis depth 
of 24 in. given in the example. 

• Choose INSERT. Then, choose OK 

18. From the Solve menu, choose Execute.  
• Click NO when the warning message is displayed saying 

“Reinforcement ratio is less than 1%. Consider column as 
architectural (i.e. fc is reduced by reinforcement ratio?)”. 

• The solver of the program is started and, upon completion, displays 
the interaction diagram of the section.  

19. From the View menu, choose Results.  
• Page through the results file. 

• Choose Exit to quit the spView program and get back to spColumn. 

20. From the File menu, choose Print Results.  
• Select the printer to send the text results to. 

• Choose PRINT. 

21. From the File menu, choose Print Screen.  
• Select the printer to send the graphical results to. 

• Choose PRINT 
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spSection Module 5-27 

 





 

 

Chapter 6  – spSection Module 
spSection Module 

spSection is an add-on module to the spColumn program. It enables the user to investigate irregularly shaped 
reinforced concrete sections subject to a combination of loadings. spSection considers a polygonal section 
reinforced with bars located at any location. The section may contain one opening. In addition, spSection 
allows easy modification of a circular section by converting it into an approximate polygon.  

spSection is accessed from within spColumn. Once spColumn is started, you can activate spSection by 
selecting the Section | Irregular command from the Input menu. This starts spSection, minimizes and locks 
the spColumn window and maximizes the spSection window. The section geometry may then be defined by 
drawing it on the screen or by inputting the coordinates of the polygon nodes. Once the section definition is 
complete, return to spColumn by selecting Save and Exit from the Main menu.  

Once the irregular section is defined, its reinforcement is input using spSection as well. This is done by 
selecting the Reinforcement | Irregular command from the Input menu of spColumn. The section 
reinforcement may also be defined graphically.  

Main Menu  

Drawing Area  
Set the limits for the drawing area and control the grid and snap settings.  

Save and Exit  
Accept the input and/or modifications made in spSection and return to spColumn.  

Exit without Saving  
Discard the input and/or modifications made in spSection and return to spColumn.  

Edit Menu  

Section  
Toggles the input/editing session to the section.  

Opening  
Toggles the input/editing session to the section opening.  

Reinforcement  
Toggles the input/editing session to the section reinforcement.  

Add  
Switches to the Add mode to graphically insert section or opening nodes or reinforcing bars.  

Delete  
Switches to the Delete mode to graphically delete section or opening nodes or reinforcing bars.  

Move  
Switches to the Move mode to graphically move section or opening nodes or reinforcing bars.  
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Modify  
Allows manual editing of the section or opening node coordinates or the reinforcing bar area and coordinates.  

View Menu  

Zoom  
Magnifies or reduces the graphical image.  

Pan  
Translates or moves the graphical image.  

Redraw  
Redraws the displayed section and resets the Zoom and Pan actions.  

Grid  
Shows or hides the grid.  

Snap  
Toggles the Snap On and Off. With the SNAP ON, the cursor snaps (sticks) to exact locations.  

Labels  
Shows or hides the internal numbering of section (or opening) nodes and bars.  

Status bar  
Shows or hides the Status bar.  

Help Menu  

spSection Help 
Lists all the available help topics about the program.  

spColumn Manual  
Opens spColumn Manual in the default PDF viewer.  

About  
Displays copyright information and the version number of the program.  

Defining the Drawing Area  
• Select Main | Drawing Area. A dialog box appears. This step is not 

needed the first time spSection is started using spColumn’s 
Section | Irregular command. The box is automatically displayed. 

• Input the limits (MINIMUM and MAXIMUM) of the area within which the 
section is to be drawn in both directions.  

• Input the interval (step) for the grid system. The grid is used as a guideline 
when drawing.  

• Select or clear the SHOW GRID option to show or hide the grid.  

• Input the interval (STEP) for the snap. The snap settings may be different 
than the grid settings and may be different in each direction (x and y).  
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• Select or clear the SNAP ON option to activate or disable the Snap.  

• Choose the OK button.  

Graphical Editing of the Section or Opening  
In spSection, the section (or opening) must be a closed polygon. It is defined by inputting the nodes at each 
corner or vertex of the polygon. No two segments (sides) may overlap or cross and no two nodes may 
coincide. An opening must lie completely within the section. 

The coordinates that correspond to the cursor location are always displayed in the Status bar. To force the 
cursor to “stick” to exact locations, turn the SNAP option on. The program will snap to locations whose 
coordinates are multiples of the snap steps. 

To add section or opening nodes:  
• Switch the input session to Section (or Opening) by selecting Edit | Section (or Edit | Opening). 

• Switch the input mode to ADD by selecting Edit | Add.  

• If you are editing a section (or opening), you must first click on an existing node. Once this is done, you 
can insert subsequent nodes.  

• Adding a node is done by moving the cursor to a desired location within the Graphics area and clicking 
the left-mouse button.  

• After inserting a node, a line extending from the last added node follows the cursor. Click at another 
location to insert subsequent nodes. A line connecting the two nodes is drawn.  

• To end the drawing, click the right-mouse button or press the ESC key. The first and last nodes are 
connected to close the section. Also note that while in the ADD mode, moving the cursor outside the 
Graphics area ends the drawing. 

To delete section or opening nodes:  
• Switch the input session to Section (or Opening) by selecting Edit | Section (or Edit | Opening).  

• Switch the input mode to DELETE by selecting Edit | Delete.  

• Marquee select the node (or nodes) to be deleted. This is done by moving the cursor to one location, 
pressing the left-mouse button and while holding the button down, moving to another location. While 
moving, a dotted rectangle (called the marquee) is drawn. Releasing the left-mouse button end the 
marquee. All nodes that are enclosed with the marquee are deleted and the section (or opening) is 
redrawn. To cancel a marquee action while holding down the left-mouse button, press the ESC key or 
click the right-mouse button. Also, leaving the Graphics area cancels the marquee operation.  

To move section or opening nodes:  
• Switch the input session to Section (or Opening) by selecting Edit | Section (or Edit | Opening). 

• Switch the input mode to Move by selecting Edit | Move. 

• Place the cursor over the node to be moved then press and hold the left-mouse button. As long as the 
button is held down, moving the cursor moves the selected node to the cursor location. Once the node is 
at the new desired location, release the mouse button. To cancel a move action while holding down the 
left-mouse button, press the ESC key or click the right-mouse button. Also, leaving the Graphics area 
cancels the move operation. 

Graphical Editing of the Reinforcement  
In spSection, the reinforcing bars may be located anywhere. The only restriction imposed in the program is 
that no two bars may overlap. The coordinates that correspond to the cursor location are always displayed in 
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the Status bar. To force the cursor to “stick” to exact locations, turn the Snap option on. The program will 
snap to locations whose coordinates are multiples of the snap steps. While in the Reinforcement session, you 
cannot switch to the Section or Opening sessions without returning to spColumn. Therefore, the 
Edit | Reinforcement command will have a check mark to its left. You use the command to specify the bar 
size or area and the number of bars to be added. 

To add one single bar at a time: 
• Switch the input mode to Add by selecting Edit | Add.  

• Select Reinforcement from the Edit menu. A dialog box appears. 

• In the Number of bars box, input 1.  

• Choose the Size option and select the size of the bar or choose the Area 
option and input the bar area in the edit box.  

• Choose the OK button.  

• In the Graphics area, point to the desired location and click. A bar is inserted.  

• Repeat the step above to insert more bars.  

To generate multiple bars:  
• Switch the input mode to Add by selecting Edit | Add. The command must have a check mark left of it.  

• Select Reinforcement from the Edit menu. A dialog box appears.  

• Input the number of bars to be generated (should be greater than 1).  

• Choose the Size option and select the size of the bar or choose the Area option and input the bar area in 
the edit box.  

• Choose the OK button.  

• In the Graphics area, click at a location (let us call it point A), move the cursor to another location and 
click (let us call it Point B). The specified number of equally-spaced bars is added, along the line 
connecting the points A and B. For subsequent generations, point B becomes A and you only need to 
click at the second point (B) to generate more bars.  

• To end the multiple bar generation or move to another location (without adding bars), click the right-
mouse button or press the ESC key. Also note that while in the multiple bar generation of the Add mode, 
moving the cursor outside the Graphics area aborts the generation.  

To delete bars:  
• Switch the input mode to DELETE by selecting Edit | Delete.  

• Marquee select the bar(s) to be deleted. This is done by moving the cursor to one location, pressing the 
left-mouse button and while holding the button down, moving to another location. While moving, a 
dotted rectangle (called the marquee) is drawn. Releasing the left-mouse button end the marquee. All 
bars that are enclosed with the marquee are deleted. To cancel a marquee action while holding down the 
left-mouse button, press the ESC key or click the right-mouse button. Also, leaving the Graphics area 
cancels the marquee operation. 

To move a bar:  
• Switch the input mode to Move by selecting Edit | Move. 

• Place the cursor over the bar to be moved then press and hold the left-mouse button. As long as the 
button is held down, moving the cursor moves the selected bar with it. Once the bar is at the new desired 
location, release the mouse button. To cancel a move action while holding down the left-mouse button, 
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press the ESC key or click the right-mouse button. Also, leaving the Graphics area cancels the move 
operation.  

Manual Editing of the Section or Opening  
• Switch the input session to Section (or Opening) by selecting 

Edit | Section (or Edit | Opening).  

• Select Edit | Modify. A dialog box appears. If you have already 
defined a section (or opening), the coordinates of its nodes are shown 
in the list. 

• To add a node, enter its x and y coordinates and choose the INSERT 
button. The entry is inserted in the list box following the selected entry.  

• To edit an entry, select it from the list box, modify its values in the text 
boxes, and choose the MODIFY button.  

• To delete an entry, choose it from the list box and choose the DELETE 
button.  

• Choose the OK button. 

Manual Editing of the Reinforcement  
• Select Edit | Modify. A dialog box appears.  

• To edit an entry, select it from the list box, modify its values in the text 
boxes, and choose the MODIFY button. You can change the area of a 
group of bars by selecting them from the list, enter the new area and 
choose MODIFY.  

• To delete an entry, choose it from the list box and choose the DELETE 
button.  

• Choose the OK button.  

Zooming and Panning the Image  
Zooming is the enlargement or reduction of the graphical image. Panning is 
the translation or movement of the image.  

Zooming:  
• Select View | Zoom.  

• To enlarge the view (zoom-in): using the left-mouse button, click anywhere within the Graphics area. 
Click again for further magnification.  

• To reduce the view (zoom-out): using the right-mouse button, click anywhere within the Graphics area. 
Click again for further reduction.  

• To reset the Zoom and return to the default, select View | Redraw.  

Panning:  
• Select View | Pan. 

• Place the cursor over the Graphics area. Press the left-mouse button and, while still holding the button, 
move the cursor in the direction you wish to pan. A line showing the amount and direction of panning is 
drawn. 
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• Release the mouse button. The view is panned and the image is redrawn. 

• To reset the Pan and return to the default, select View | Redraw. 

Keyboard shortcuts:  
The following keyboard assignments are always active: 

Key combination Action 

Ctrl + Page Up Zoom-in 

Ctrl + Page Down Zoom-out 

Ctrl + Cursor key Pan 

Enter Reset zoom/pan (Redraw) 

Example 5 – Capacity of an Irregular Section  
Compute horizontal moment capacity Mx of the unsymmetrical beam cross 
section77 shown below. Use 3-ksi concrete and 60-ksi reinforcing steel. 

 
Note: when instructed to move to a location (15, 25), move the cursor until the cells in the Status bar show 
“x=15” and “y=25”. 

From the File menu, choose New. Any input data is cleared and 
the default values are restored.  

1. From the Input menu, choose General Information.  
• Select English units and ACI 318-08 code.  

• Select BIAXIAL for RUN AXIS, Investigation for run 
option and NO for CONSIDER SLENDERNESS? 

• Choose OK.  

2. From the Input menu, choose Material Properties.  
• Under CONCRETE, input 3 for the STRENGTH. Other pro-

perties are computed and will be accepted. 

• Choose OK. 

                                                           
77 Based on Example 4.7, pp 161 from Reinforced Concrete: Mechanics and Design by James G. Wight and James K. MacGregor, Fifth 
Edition, 2009, Pearson Prentice Hall, Pearson Education Inc. 
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3. From the Input menu, choose Section | Irregular. The spSection module is 
loaded, its window occupies the desktop, and the DRAWING AREA box 
appears.  
• Under Limits, input 0 and 20 for the MINIMUM X and MINIMUM Y, 

respectively.  

• Under limits, input 24 and 4 for the MAXIMUM X and MAXIMUM Y, 
respectively.  

• Under GRID, input 4 and 4 for X and Y grid STEP, respectively and check 
the SHOW GRID option.  

• Under SNAP, input 4 and 4 for X and Y STEP, respectively and check the 
SNAP ON option.  

• Choose OK. 

4. The default input session is Section and the default input mode is Add (the 
Edit | Section and Edit | Add options are checked). 
• In the Graphics area, move the cursor to the location (0, 0) and click the left mouse button. A node is 

inserted. 

• Move to (12, 0) and click the left mouse button. 

• Move to (12, -20) and click the left mouse button. 

• Move to (24, -20) and click the left mouse button. 

• Move to (24, 4) and click the left mouse button. 

• Move to (0, 4) and click the left mouse button. 

• Move to (0, 0) and click the left mouse button. 

• Click the right-mouse button to end drawing the section. 

5. From the Main menu, choose Save and Exit. You are returned to spColumn 
and the section is shown in the Information bar.  

6. From the Input menu, choose Reinforcement | Irregular. The spSection 
module is loaded, its window occupies the desktop. 

7. The default input session is Reinforcement and the default input mode is Add 
(the Edit | Reinforcement and Edit | Add options are checked).  

8. Define some bars using multiple bar generation: 
• From the Edit menu, choose Reinforcement. Input 1 for the NUMBER 

OF BARS and select #9 for the BAR SIZE. Choose OK.  

•  Move the cursor to any location and click the left mouse button.  

• From the Edit menu, choose Modify. Input 14.142 for X-COORD and -
17.5 for Y-COORD. Click MODIFY and then OK. 

• From the Edit menu, choose Reinforcement. Input 1 for the NUMBER 
OF BARS and select #8 from BAR SIZE. Choose OK.  

• Move the cursor to any location and click the left mouse button. A #8 
bar is generated at that location.  

• From the Edit menu choose Modify. Input 18 for X-COORD and -17.5 
for Y-COORD. Click MODIFY and then OK. 

• From the Edit menu, choose Reinforcement. Input 1 for the NUMBER 
OF BARS and select #8 from BAR SIZE. Choose OK. 
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• Move the cursor to any location and click the left mouse button. A #8 bar is generated at that 
location.  

• From the Edit menu choose Modify. Input 22 for X-COORD and -17.5 for Y-COORD. Click Modify 
and then Ok  

 
9.  From the Main menu, choose Save and Exit. You are returned to spColumn and the section is shown in 

the Information bar.  
10. From the Input menu, choose Input | Loads | .Factored 
11. Enter LOAD as 0 (zero), X-MOMENT as -225 ft-kips and Y-MOMENT as 0.  
12. From the Solve menu, choose Execute.  

• A message is displayed saying “Reinforcement ratio is less than 1% 
Consider column as architectural (i.e. fc is reduced by reinforcement 
ratio?)”. Click NO for this option. 

• The solver of the program is started and, upon completion, displays 
the interaction diagram of the section.  

13. From the View menu, choose Results.  
• Page through the results file. 

• Choose Exit to quit the spView program and get back to spColumn. 

14. From the File menu, choose Print Results.  
• Select the printer to send the text results to. 

• Choose PRINT. 

15. From the File menu, choose Print Screen.  
• Select the printer to send the graphical results to. 

• Choose PRINT 

• Change the interaction diagram to show the P-M diagram at 180o using the  icon. 
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 Appendix 
Import File Formats 

Geometry, reinforcement or load data may be imported from a text file. The import file must be saved in pure 
ASCII (text) format. Data fields on each line should be separated by spaces or TABs. Comments or blank 
lines should not be placed within the import file. 

Service Loads Data: 
No_Of_Load_Points 
P1_D M1x_DT M1x_DB M1y_DB M1y_DB 
P1_L M1x_LT M1x_LB M1y_LT M1y_LB 
P1_W M1x_WT M1x_WB M1y_WT M1y_WB 
P1_EQ M1x_EQT M1x_EQB M1y_EQT M1y_EQB 
P1_S M1x_ST M1x_SB M1y_ST M1y_SB 
... 
Pn_D Mnx_DT Mnx_DB Mny_DB Mny_DB 
Pn_L Mnx_LT Mnx_LB Mny_LT Mny_LB 
Pn_W Mnx_WT Mnx_WB Mny_WT Mny_WB 
Pn_EQ Mnx_EQT Mnx_EQB Mny_EQT Mny_EQB 
Pn_S Mnx_ST Mnx_SB Mny_ST Mny_SB 
 
Each service load point has five lines of data (one line for each load case, i.e. Dead, Live, Wind, Earthquake, 
and Snow). Each data line has five values. For a service load point i, Pi_D, Mix_DT, Mix_DB, Miy_DT, 
and Miy_DB are the axial load, Mx at top, Mx at bottom, My at top and My at bottom, respectively. The 
notation D, L, W, EQ, and S designate the Dead, Live, Wind, Earthquake, and Snow load cases, 
respectively. 

Factored Loads Data: 
No_Of_Load_Points 
P1 M1x M1y 
P2 M2x M2y 
... 
Pn Mnx Mny 
 
For a factored load point i, Pi is the factored axial load, Mix is the factored moment about x and Miy is the 
factored moment about y. 

Reinforcement Data: 
No_Of_Bars 
A1 X1 Y1 
... 
An Xn Yn 
 
For a bar i, Ai is the bar area, Xi is its x-coordinate, and Yi is its y-coordinate. 

Geometry Data: 
No_Of_Section_Nodes 
Xs1 Ys1 
Xs2 Ys2 
... 
Xsn Ysn 
No_Of_Opening_Nodes 
Xo1 Yo1 
Xo2 Yo2 
... 
Xon Yon 
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For a section node si, Xsi is the x-coordinate of the node and Ysi is its y-coordinate. 

For an opening node oi, Xoi is the x-coordinate of the node and Yoi is its y-coordinate. 

If the section does not contain an opening, you must have a zero for the value of No_Of_Opening_Nodes. 
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spColumn Text Input (CTI) file format 
spColumn is able to read and save its input data into two file formats, COL file or CTI file. CTI files are plain 
text files that can be edited by any text editing software. 

Caution must be used when editing a CTI file because some values may be interrelated. If one of these values 
is changed, then other interrelated values should be changed accordingly. While this is done automatically 
when a model is edited in the spColumn user graphic user interface (GUI), one must update all the related 
values in a CTI file manually in order to obtain correct results. For example, if units are changed from 
English to Metric in GUI, all the related input values are updated automatically. If this is done by editing a 
CTI file, however, not only the unit flag but also all the related input values must be updated manually. 

The best way to create a CTI file is by using the spColumn GUI and selecting CTI file type in the Save As 
menu command. Then, any necessary modifications to the CTI file can be applied with any text editor. 
However, it is recommended that users always verify modified CTI files by loading them in the spColumn 
GUI to ensure that the modifications are correct before running manually revised CTI files in batch mode. 

The CTI file is organized by sections. Each section contains a title in square brackets, followed by values 
required by the section. The CTI file contains the following sections. 

[spColumn Version] 
[Project] 
[Column ID] 
[Engineer] 
[Investigation Run Flag] 
[Design Run Flag] 
[Slenderness Flag] 
[User Options] 
[Irregular Options] 
[Ties] 
[Investigation Reinforcement] 
[Design Reinforcement] 
[Investigation Section Dimensions] 
[Design Section Dimensions] 
[Material Properties] 
[Reduction Factors] 
[Design Criteria] 
[External Points] 
[Internal Points] 
[Reinforcement Bars] 
[Factored Loads] 
[Slenderness: Column] 
[Slenderness: Column Above And Below] 
[Slenderness: Beams] 
[EI] 
[SldOptFact] 
[Phi_Delta] 
[Cracked I] 
[Service Loads] 
[Load Combinations] 
[BarGroupType] 
[User Defined Bars] 
[Sustained Load Factors] 

Each section of a CTI file and allowable values of each parameter are described in details below. 
Corresponding GUI commands are presented in parenthesis. 

#spColumn Text Input (CTI) File 
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The number sign, #, at the beginning of a line of text indicates that the line of text is a comment. The # sign 
must be located at the beginning of a line. Comments may be added anywhere necessary in a CTI file to make 
the file more readable. If a comment appears in multiple lines, each line must be started with a # sign. 

[spColumn Version] 

Reserved. Do not edit. 

[Project] 

There is one line of text in this section.  

Project name (menu Input | General Information…) 

[Column ID] 

There is one line of text in this section.  

Column ID (menu Input | General Information…) 

[Engineer] 

There is one line of text in this section.  

Engineer name (Menu Input | General Information…) 

[Investigation Run Flag] 

Reserved. Do not edit. 

[Design Run Flag] 

Reserved. Do not edit. 

[Slenderness Flag] 

Reserved. Do not edit. 

[User Options] 

There are 26 values separated by commas in one line in this section. These values are described below in the 
order they appear from left to right. 

1. 0-Investigation Mode; 1-Design Mode; (Run Option on menu Input | General Information…) 
2. 0-English Unit; 1-Metric Units; (Units on menu Input | General Information…) 
3. 0-ACI 318-02; 1- CSA A23.3-94; 2-ACI 318-05; 3-CSA A23.3-04; 4-ACI 318-08; (Design Code on 

menu Input | General Information…) 
4. 0-X Axis Run; 1-Y Axis Run; 2-Biaxial Run; (Run Axis on menu Input | General Information…) 
5. Reserved. Do not edit. 
6. 0-Slenderness is not considered; 1-Slenderness in considered; (Consider slenderness? on menu Input | 

General Information…) 
7. 0-Design for minimum number of bars; 1-Design for minimum area of reinforcement; (Bar selection 

on menu Input | Reinforcement | Design Criteria…) 
8. Reserved. Do not edit. 
9. 0-Rectangular Column Section; 1-Circular Column Section; 2-Irregular Column Section; (menu Input | 

Section) 
10. 0-Rectangular reinforcing bar layout; 1-Circular reinforcing bar layout; (Bar Layout on menu Input | 

Reinforcement | All Sides Equal) 
11. 0-Structural Column Section; 1-Architectural Column Section; 2-User Defined Column Section; 

(Column Type on menu Input | Reinforcement | Design Criteria…) 
12. 0-Tied Confinement; 1-Spiral Confinement; 2-Other Confinement; (Confinement drop-down list on 

menu Input | Reinforcement | Confinement…) 
13. Load type for investigation mode: (menu Input | Loads) 
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0-Factored; 1-Service; 2-Control Points; 3-Axial Loads 
14. Load type for design mode: (menu Input | Loads) 

0-Factored; 1-Service; 2-Control Points; 3-Axial Loads 
15. Reinforcement layout for investigation mode: (menu Input | Reinforcement) 

0-All Side Equal; 1-Equal Spacing; 2-Sides Different; 3-Irregular Pattern 
16. Reinforcement layout for design mode: (menu Input | Reinforcement) 

0-All Side Equal; 1-Equal Spacing; 2-Sides Different; 3-Irregular Pattern 
17. Reserved. Do not edit. 
18. Number of factored loads (menu Input | Loads | Factored…) 
19. Number of service loads (menu Input | Loads | Service…) 
20. Number of points on exterior column section  
21. Number of points on interior section opening 
22. Reserved. Do not edit. 
23. Reserved. Do not edit. 
24. Cover type for investigation mode: (menu Input | Reinforcement) 

0-To transverse bar; 1-To longitudinal bar 
25. Cover type for design mode: (menu Input | Reinforcement) 

0-To transverse bar; 1-To longitudinal bar 
26. Number of load combinations; (menu Input | Load | Load Combinations…) 

[Irregular Options] 

There are 13 values separated by commas in one line in this section. These values are described below in the 
order they appear from left to right. (menu Input | Section | Irregular | Section Editor menu Main | Drawing 
Area) 

1. Reserved. Do not edit. 
2. Reserved. Do not edit. 
3. Reserved. Do not edit. 
4. Reserved. Do not edit. 
5. Area of reinforcing bar that is to be added through irregular section editor 
6. Maximum X value of drawing area of irregular section editor 
7. Maximum Y value of drawing area of irregular section editor 
8. Minimum X value of drawing area of irregular section editor 
9. Minimum Y value of drawing area of irregular section editor 
10. Grid step in X of irregular section editor 
11. Grid step in Y of irregular section editor 
12. Grid snap step in X of irregular section editor 
13. Grid snap step in Y of irregular section editor 

[Ties] 

There are 3 values separated by commas in one line in this section. These values are described below in the 
order they appear from left to right. (Menu Input | Reinforcement | Confinement…) 

1. Index (0 based) of tie bars for longitudinal bars smaller that the one specified in the 3rd item in this 
section in the drop-down list 

2. Index (0 based) of tie bars for longitudinal bars bigger that the one specified in the 3rd item in this 
section in the drop-down list 

3. Index (0 based) of longitudinal bar in the drop-down list 

[Investigation Reinforcement] 

This section applies to investigation mode only. There are 12 values separated by commas in one line in this 
section. These values are described below in the order they appear from left to right. 

If Side Different (Menu Input | Reinforcement | Side Different…) is selected: 

1. Number of top bars 
2. Number of bottom bars 
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3. Number of left bars 
4. Number of right bars 
5. Index (0 based) of top bars (Top Bar Size drop-download list) 
6. Index (0 based) of bottom bars (Bottom Bar Size drop-download list) 
7. Index (0 based) of left bars (Left Bar Size drop-download list) 
8. Index (0 based) of right bars (Right Bar Size drop-download list) 
9. Clear cover to top bars 
10. Clear cover to bottom bars 
11. Clear cover to left bars 
12. Clear cover to right bars 

If All Sides Equal (Menu Input | Reinforcement | All Sides Equal…) or Equal Spacing (Menu Input | 
Reinforcement | Equal Spacing…) is selected: 

1. Number of bars (No. of Bars text box) 
2. Reserved. Do not edit. 
3. Reserved. Do not edit. 
4. Reserved. Do not edit. 
5. Index (0 based) of bar (Bar Size drop-down list) 
6. Reserved. Do not edit. 
7. Reserved. Do not edit. 
8. Reserved. Do not edit. 
9. Clear cover to bar (Clear Cover text box) 
10. Reserved. Do not edit. 
11. Reserved. Do not edit. 
12. Reserved. Do not edit. 

If Irregular Pattern (Menu Input | Reinforcement | Irregular Pattern…) is selected: 

Reserved. Do not edit. 

[Design Reinforcement] 

This section applies to design mode only. There are 12 values separated by commas in one line in this section. 
These values are described below in the order they appear from left to right. 

If Side Different (Menu Input | Reinforcement | Side Different…) is selected: 

1. Minimum number of top and bottom bars 
2. Maximum number of top and bottom bars 
3. Minimum number of left and right bars 
4. Maximum number of left and right bars 
5. Index (0 based) of minimum size for top and bottom bars 
6. Index (0 based) of maximum size for top and bottom bars 
7. Index (0 based) of minimum size for left and right bars 
8. Index (0 based) of maximum size for left and right bars 
9. Clear cover to top and bottom bars 
10. Reserved. Do not edit. 
11. Clear cover to left and right bars 
12. Reserved. Do not edit. 

If All Sides Equal (Menu Input | Reinforcement | All Sides Equal…) or Equal Spacing (Menu Input | 
Reinforcement | Equal Spacing…) is selected: 

1. Minimum number of bars 
2. maximum number of bars 
3. Reserved. Do not edit. 
4. Reserved. Do not edit. 
5. Index (0 based) of minimum size of bars 
6. Index (0 based) of maximum size of bars 
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7. Reserved. Do not edit. 
8. Reserved. Do not edit. 
9. Clear cover 
10. Reserved. Do not edit. 
11. Reserved. Do not edit. 
12. Reserved. Do not edit. 

[Investigation Section Dimensions] 

This section applies to investigation mode only. There are 2 values separated by commas in one line in this 
section. These values are described below in the order they appear from left to right. 

If rectangular section (Menu Input | Section | Rectangular…) is selected: 

1. Section width (along X) 
2. Section depth (along Y) 

If circular section (Menu Input | Section | Circular…) is selected: 

1. Section diameter 
2. Reserved. Do not edit. 

If irregular section (Menu Input | Section | Irregular) is selected: 

1. Reserved. Do not edit. 
2. Reserved. Do not edit. 

[Design Section Dimensions] 

This section applies to design mode only. There are 6 values separated by commas in one line in this section. 
These values are described below in the order they appear from left to right. 

If rectangular section (Menu Input | Section | Rectangular…) is selected: 

1. Section width (along X) Start 
2. Section depth (along Y) Start 
3. Section width (along X) End 
4. Section depth (along Y) End 
5. Section width (along X) Increment 
6. Section depth (along Y) Increment 

If circular section (Menu Input | Section | Circular…) is selected: 

1. Diameter start 
2. Reserved. Do not change. 
3. Diameter end 
4. Reserved. Do not change. 
5. Diameter increment 
6. Reserved. Do not change. 

[Material Properties] 

There are 8 values separated by commas in one line in this section. These values are described below in the 
order they appear from left to right. (Menu Input | Material Properties…) 

1. Concrete strength, f’c 
2. Concrete modulus of elasticity, Ec 
3. Concrete maximum stress, fc 
4. Beta(1) for concrete stress block 
5. Concrete ultimate strain 
6. Steel yield strength, fy 
7. Steel modulus of elasticity, Es 
8. Reserved. Do not edit. 
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[Reduction Factors] 

There are 4 values separated by commas in one line in this section. These values are described below in the 
order they appear from left to right. (Menu Input | Reinforcement | Confinement…) 

1. Phi(a) for axial compression 
2. Phi(b) for tension-controlled failure 
3. Phi(c) for compression-controlled failure 
4. Reserved. Do not edit. 

[Design Criteria] 

There are 4 values separated by commas in one line in this section. These values are described below in the 
order they appear from left to right. (Menu Input | Reinforcement | Design Criteria…) 

1. Minimum reinforcement ratio 
2. Maximum reinforcement ratio 
3. Minimum clear spacing between bars 
4. Design/Required ratio 

[External Points] 

This section applies to irregular section in investigation mode only. The first line contains the number of 
points on exterior section perimeter. Each of the following lines contains 2 values of X and Y coordinates 
(separated by comma) of a point. 

Number of Points, n 
Point_1_X, Point_1_Y 
Point_2_X, Point_2_Y 
... 
Point_n_X, Point_n_Y 

[Internal Points] 

This section applies to irregular section in investigation mode only. The first line contains the number of 
points on an interior opening perimeter. Each of the following lines contains 2 values of X and Y coordinates 
(separated by comma) of a point. If no opening exists, then the first line must be 0. 

Number of Points, n 
Point_1_X, Point_1_Y 
Point_2_X, Point_2_Y 
... 
Point_n_X, Point_n_Y 

[Reinforcement Bars] 

This section applies to irregular section in investigation mode only. The first line contains the number of 
reinforcing bars. Each of the following lines contains 3 values of area, X and Y coordinates (separated by 
comma) of a bar.  

Number of bars, n 
Bar_1_area, Bar_1_X, Bar_1_Y 
Bar_2_area, Bar_2_X, Bar_2_Y 
... 
Bar_n_area, Bar_n_X, Bar_n_Y 

[Factored Loads] 

The first line contains the number of factored loads defined. Each of the following lines contains 3 values of 
axial load, X-moment, and Y-moment separated by commas. (Menu Input | Loads | Factored Loads…) 

Number of Factored Loads, n 
Load_1, X-Moment_1, Y-Moment_1 
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Load_2, X-Moment_2, Y-Moment_2 
... 
Load_n, X-Moment_n, Y-Moment_n 

[Slenderness: Column] 

This section contains 2 lines describing slenderness parameters for column being designed. The first line is 
for X-axis parameters, and the second line is for Y-axis parameters. 

There are 8 values78 separated by commas in each line. These values are described below in the order they 
appear from left to right. (Menu Input | Slenderness | Design Column…) 

1. Column clear height 
2. k(nonsway) 
3. k(sway) 
4. 0-Nonsway frame; 1-Sway frame 
5. 0-Compute ‘k’ factors; 1-Input k factors 
6. (ΣPc)/Pc 
7. (ΣPu)/Pu 
8. 0-Do not ignore moment magnification along column length in sway frames; 1-Ignore moment 

magnification along column length in sway frames. Use for ACI 318-08 only. For all other codes the 
value must be 0. 

[Slenderness: Column Above And Below] 

This section contains 2 lines describing slenderness parameters for column above and column below. The first 
line is for column above, and the second line is for column below. (Menu Input | Slenderness | Columns 
Above/Below…) 

There are 6 values separated by commas in line 1 for column above. These values are described below in the 
order they appear from left to right.  

1. 0-Column specified; 1-No column specified 
2. Column Height 
3. Column width (along X) 
4. Column depth (along Y) 
5. Concrete compressive strength, f’c 
6. Concrete modulus of elasticity, Ec 

There are 6 values separated by commas in line 2 for column below. These values are described below in the 
order they appear from left to right. 

1. 0-Column specified; 1-No column specified 
2. Column Height 
3. Column width (along X) 
4. Column depth (along Y) 
5. Concrete compressive strength, f’c 
6. Concrete modulus of elasticity, Ec 

[Slenderness: Beams] 

This section contains 8 lines. Each line describes a beam.  

Line 1: X-Beam (perpendicular to X), Above Left 
Line 2: X-Beam (perpendicular to X), Above Right 
Line 3: X-Beam (perpendicular to X), Below Left 
Line 4: X-Beam (perpendicular to X), Below Right 
Line 5: Y-Beam (perpendicular to Y), Above Left 
Line 6: Y-Beam (perpendicular to Y), Above Right 

                                                           
78 Value No 8 introduced in spColumn v4.60. 
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Line 7: Y-Beam (perpendicular to Y), Below Left 
Line 8: Y-Beam (perpendicular to Y), Below Right 

There are 7 values separated by commas for each beam in each line. (Menu Input | Slenderness | X-Beams…, 
Input | Slenderness | Y-Beams…) These values are described below in the order they appear from left to right. 

1. 0-beam specified; 1-no beam specified 
2. Beam span length (c/c) 
3. Beam width 
4. Beam depth 
5. Beam section moment of inertia 
6. Concrete compressive strength, f’c 
7. Concrete modulus of elasticity, Ec 

[EI] 

Reserved. Do not edit. 

[SldOptFact] 

There is 1 value in this section for slenderness factors. (Code Default and User Defined radio buttons on 
menu Input | Slenderness | factors…) 

0-Code default; 1-User defined 

[Phi_Delta] 

There is 1 value in this section for slenderness factors. (Menu Input | Slenderness | factors…) 

Stiffness reduction factor 

[Cracked I] 
There are 2 values separated by commas in one line in this section. These values are described below in the 
order they appear from left to right. (Menu Input |  

Slenderness | factors…) 

1. Beam cracked section coefficient 
2. Column cracked section coefficient 

[Service Loads] 

This section describes defined service loads. (Menu Input | Loads | Service…) The first line contains the 
number of service loads. Each of the following lines contains values for one service load. 

There are 25 values for each service load in one Line separated by commas. These values are described below 
in the order they appear from left to right. 

1. Dead Axial Load 
2. Dead X-moment at top 
3. Dead X-moment at bottom 
4. Dead Y-moment at top 
5. Dead Y-moment at bottom 
6. Live Axial Load 
7. Live X-moment at top 
8. Live X-moment at bottom 
9. Live Y-moment at top 
10. Live Y-moment at bottom 
11. Wind Axial Load 
12. Wind X-moment at top 
13. Wind X-moment at bottom 
14. Wind Y-moment at top 
15. Wind Y-moment at bottom 
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16. EQ. Axial Load 
17. EQ. X-moment at top 
18. EQ. X-moment at bottom 
19. EQ. Y-moment at top 
20. EQ. Y-moment at bottom 
21. Snow Axial Load 
22. Snow X-moment at top 
23. Snow X-moment at bottom 
24. Snow Y-moment at top 
25. Snow Y-moment at bottom 

[Load Combinations] 

This section describes defined load combinations. (Menu Input | Loads | Load Combinations…) The first line 
contains the number of load combinations. Each of the following lines contains load factors for one load 
combination. 

Number of load combinations, n 
Dead_1, Live_1, Wind_1, E.Q._1, Snow_1 
Dead_2, Live_2, Wind_2, E.Q._2, Snow_2 
... 
Dead_n, Live_n, Wind_n, E.Q._n, Snow_n 

[BarGroupType] 

There is 1 value in this section. (Bar Set drop-down list on menu Options | Reinforcement…) 

0-User defined 
1-ASTM615 
2-CSA G30.18 
3-prEN 10080 
4-ASTM615M 

[User Defined Bars] 

This section contains user-defined reinforcing bars. (Menu Options | Reinforcement…) The first line contains 
the number of defined bars. Each of the following lines contains values for one bar separated by commas. 

Number of user-defined bars, n 
Bar_1_size, Bar_1_diameter, Bar_1_area, Bar_1_weight 
Bar_2_size, Bar_2_diameter, Bar_2_area, Bar_2_weight 
... 
Bar_n_size, Bar_n_diameter, Bar_n_area, Bar_n_weight 

[Sustained Load Factors] 

There are 5 values separated by commas in one line in this section. Each value respectively represents 
percentage of Dead, Live, Wind, EQ, and Snow load case that is considered sustained (Menu Input | Loads | 
Service…). 
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Conversion Factors - English to SI 

To convert from  To  Multiply by 
in. m (1000 mm)  0.025400 
ft m  0.304800 
lb N (0.001 kN)  4.448222 

kip (1000 lbs)  kN  4.448222 
plf (lb/ft)  N/m  14.593904 

psi (lb/in.2)  kPa  6.894757 
ksi (kips/in.2)  MPa  6.894757 

psf (lb/ft2)  N/m2 (Pa)  47.88026 
pcf (lb/ft3)  kg/m3  16.018460 

ft-kips  kN • m  1.355818 
 

Conversion Factors - SI to English. 
 

To convert from To  Multiply by  
m (1000 mm) in  39.37008  

m ft  3.28084  
N (0.001 kN) lb  0.224809  

kN kip (1000 lbs)  0.224809  
kN/m plf (lb/ft)  68.52601  
MPa psi (lb/in2)  145.0377  
MPa ksi (kips/in2)  0.145038  

kN/m2 (kPa) psf (lb/ft2)  20.88555  
kg/m3  pcf (lb/ft3)  0.062428  
kN • m  ft-kips  0.737562  
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Contact Information 
 

Web Site:  http://www.StructurePoint.org 

E-mail:  info@StructurePoint.org  
 support@StructurePoint.org  

 StructurePoint, LLC.  
 5420 Old Orchard Road  
 Skokie, IL 60077  
 USA  
Phone:  (847) 966-4357  
Fax:  (847) 966-1542  
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